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Abstract
We present a methodology for systematically extending epidemic models

to multilevel and multiscale spatio-temporal pandemic ones. Our approach
builds on the use of coloured stochastic and continuous Petri nets facilitat-
ing the sound component-based extension of basic SIR models to include
population stratification and also spatio-geographic information and travel
connections, represented as graphs, resulting in robust stratified pandemic
metapopulation models. This method is inherently easy to use, producing
scalable and reusable models with a high degree of clarity and accessibility
which can be read either in a deterministic or stochastic paradigm. Our
method is supported by a publicly available platform PetriNuts; it enables
the visual construction and editing of models; deterministic, stochastic and
hybrid simulation as well as structural and behavioural analysis. All the
models are available as supplementary material, ensuring reproducibility.
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1 Introduction
We present a methodology for modelling pandemics, the development of which
was motivated by the current COVID19 outbreak. The key point of our approach
is the introduction of geography and travel connections in a well founded man-
ner, facilitating intuitive understanding by modellers, clinicians, epidemiologists,
public health strategists, politicians, and other key stakeholders.

Our modelling approach builds on the use of coloured stochastic and contin-
uous Petri nets which facilitates the sound component-based extension of basic
SIR models to include population stratification and also spatio-geographic in-
formation, resulting in robust stratified pandemic metapopulation models. This
method is inherently easy to use, producing scalable and reusable models with a
high degree of clarity and accessibility which can be read either in a stochastic
or deterministic paradigm, the latter mapping to Ordinary Differential Equations
(ODEs). The ODEs are uniquely defined by the Petri net models and are auto-
matically generated by our simulators. In turn this conforms with sound model
engineering practice, with the aim of minimising encoding errors.

The models which we obtain by our method are multilevel, the lower level
comprising homogeneous SIR models, and the upper level being a network of
geographical connections. Thus our methodology enables the construction and
analysis of metapopulation models. The models are multiscale in terms of dis-
tances, which are explicit at the upper geographical level and implicit at the
lower homogeneous level, and multiscale in terms of time in that we assume that
geographical connections (travel) occur at a much lower rate than infections in
lower level SIR components.

Our method is supported by a publicly available platform PetriNuts which
enables visual construction and editing of models; deterministic, stochastic and
hybrid simulation as well as structural and behavioural analysis. All the models
presented in this paper are provided as Supplementary Material, and can be
processed using the platform, thus ensuring reproducibility.

2 Results

2.1 Basic epidemic SIR model in Petri nets

We start off with the standard SIR epidemic model and the usual assumptions
(see Methods section); its Petri net representation is given in Figure 1.

The infection rate is effectively the observed increase in the number of daily
infections, more generally the number of infections in a given time period, typi-
cally described by mass action kinetics [WW45]. An alternative approach, called
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the standard incidence, normalises the infection rate by the total population size
N , based on the assumption that daily encounters between individuals in the
population are largely independent of community size [Het00]. The rate constant
of infection kinfect (the parameter for mass action kinetics) is driven by both the
infectiousness of the disease, as well as any societal prevention measure in place
(isolation etc.). Likewise, the recovery rate is governed by the rate constant of
recovery krecover which reflects the contribution of all the factors contributing to
recovery - health of the individuals in the population, treatment etc.

These infection and recovery rates correspond to the rate functions associated
with the transitions Infect and Recover in the Petri net model. Rate functions
can be interpreted in two different ways: stochastic or deterministic, thus yielding
stochastic Petri nets (SPN ) or continuous Petri nets (CPN ). The semantics of
SPN is given by continuous time Markov chains (CTMC), and the semantics of
CPN by Ordinary Differential Equations (ODEs). The ODEs generated reading
the Petri net in Figure 1 as a CPN are given in Equation 1, which correspond
exactly to the ODEs given in the literature. We observe that each place gets
its own equation (see Methods section for the automatic translation of CPN
into ODEs). In the equations we have replaced the long place names by their
standard short forms for readability. The formulae governing the rates according
to the standard incidence can be easily adjusted to use the mass action kinetics
by setting N = 1.

dS

dt
= −kinfect ·

S

N
· I (1)

dI

dt
= kinfect ·

S

N
· I − krecover · I

dR

dt
= krecover · I

To obtain a flexible model, we introduce constants S0, I0 and R0 to initialise
the places Susceptible, Infectious and Recovered ; thus, N = S0 + I0 + R0. In
general, the initial values of all the places in a model form its initial state at time
t = 0. We also use, for example, the notation S0 to stand for the value of St=0,
or generally St for time point t.

These models are typically simulated, which for SPN means making random
walks through the CTMC, applying e.g. Gillespie’s stochastic simulation algo-
rithm (SSA) [Gil76], and for CPN solving the underlying ODEs. Figure 1 gives
simulation traces for both cases. Even without realistic rate constants, this basic
model already permits some interesting computational experiments, see section
on parameter fitting.
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[DRG 3/12/20]
Standard SIR model
R - Recovered [rather than Removed]
With initial markings/rates:
Susceptible - 100
Infectious - 1
Recovered - 0
Infect - MassAction(0.1)
Recover - MassAction(1)
These rates will need to be changed if e.g. 
the initial marking on Susceptible is changed (increased)

Infectious

I0

RecoveredSusceptible

S0
Infect Recover

2

Figure 1: SIR model. (Top) A Petri Net describing the SIR model where Petri
net places (circles) represent the Susceptible (S), Infectious (I) and Recovered (R)
compartments. Petri net transitions (squares) represent the actions (events) of
becoming infectious and recovering, and arcs connect places with transitions en-
abling events to occur and describing the effect of the occurrence. At the Infect
transition, an infection will only occur when a susceptible and infectious person
meet reducing the number in both compartments by 1. This results in two people
being added to the Infectious place which is represented by an arc weight of 2
(shorthand notation for two arcs). Note that the default arc weight of 1 is not
given. Also the number of infectious people can be reduced by 1 via the Recover
transition, increasing Recovered by 1. Each transition preserves the number of
persons (the number of incoming arcs equals the number of outgoing arcs), thus
the net is conservative and the total population size is constant. (Bottom) From
left to right: Two single stochastic runs and the deterministic run, with S0 = 100,
I0 = 1, kinfect = 0.1, krecover = 1. Note, in the second stochastic run, Infectious
dies out much earlier than in the deterministic simulation.
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We make some observations about the behaviour of the system. There is a
trivial, i.e. disease free steady state for I0 = 0 so that no infections or recovery
occur, otherwise the steady state is reached when It = 0. We note some interesting
SPN behaviour of single runs – there is a probability that the infection dies out
early, whatever the balance between the rates of infection and recovery, due to
the underlying Markov chain. In contrast, the ODE behaviour can be thought
of as the average over many stochastic runs, and thus ignores the variability
inherent in a stochastic model. Besides exploring time series of model variables,
we can also define derived measures as observers, such as the reproduction number
R [HSW05,vdD17]; see Methods section for details.

All our models can be equally read as SPN or CPN .

2.2 Extended epidemic models

The SIR model can be extended by extra compartments such as deaths (D),
maternally-derived immunity (M), exposed/incubation period (E) etc., and ex-
tra variables such as total number of infectious, total deaths, yielding varia-
tions of the basic SIR model including SIS, SIRS, SIRD, MSIR, SEIR, SEIS,
MSEIR, MSEIRS [Het00]. Their representation as a Petri net model is straight-
forward, and Petri net animation supports the modeller in getting the model
structure right. Some illustrative models from this paper can be animated
in a web browser at https://www-dssz.informatik.tu-cottbus.de/DSSZ/
Research/ModellingEpidemics.

Here we consider two examples which are relevant to the current COVID19
epidemic (Figure 2):

• SIQR model which describes, as an additional route to recovery, the
possibility of infectious people being subject to quarantine before recov-
ery [ASGS20].

• SIAR model which differentiates infectious people into symptomatic and
asymptomatic compartments [SIAQN17].
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Susceptible
S0

RecoveredInfectious
I0

Quarantine
Infect

Recover

To_Quar Quar_To_Rec

2

InfectiousSymptomatic

I0

RecoveredSymptomatic

SusceptibleS0

InfectiousAsymptomatic
RecoveredAsymptomatic

Infect

RecoverSymptomatic

InfectBySymptomaticBecomeAsymptomatic

BecomeSymptomatic

RecoverAsymptomatic

InfectByAsymptomaticBecomeAsymptomatic

InfectByAsymptomaticBecomeSymptomatic

2

2

Figure 2: Two extended epidemic models. (Top) SIQR - an SIR model
extended by quarantine. (Bottom) SIAR - an SIR model with symptomat-
ic/asymptomatic compartments. There are four different cases of infection re-
flected by the four transitions connected with the Susceptible place. The two
which involve only one infectious compartment – InfectiousSymptomatic or In-
fectiousAsymptomatic – follow the standard SIR pattern, reflected in the outgoing
arc weights of 2. In the cases of the two dual outcome infections – Susceptible
and InfectiousSymtomatic to InfectiousAsymptomatic or vice versa, there are two
outgoing arcs to the two infectious places each of which has an arc weight of 1
(not shown by default). The total rate of infection in the whole population is the
sum of the rates of the four infection transitions. The ODEs of these two models
are given in the Supplementary Material.
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2.3 Stratified epidemic models

In general, modelling the stratification of a population in terms of epidemics
means that the overall population is partitioned into a number of strata and
a suitable model is defined for each stratum and their appropriate interconnec-
tions. The compartments are equally divided into disjunctive sets, such that each
partition is internally homogeneous and distinctively differs from all the other
partitions, and there are corresponding partitions in all compartments.

In the following we assume that the same epidemic model is equally applied
to each stratum. As an example we consider SIR-Sage

2 , an SIR model with two age
strata (Figure 3 (Top)). See Methods section for an explanation of our naming
convention for models.

Clearly the stratification in this model is very minimal; the standard practice
when collecting statistics of infections is to use more than two age groups - often
in 10 deciles from 0 to 100 years old. A model should describe all the possi-
ble combinations of cross infections, in this case we obtain 10 · 10 = 100 infect
transitions. The modelling effort invites modelling errors; this will be further
compounded if gender is added to age in the stratification. To cope with this
modelling challenge, we use coloured Petri nets.

Coloured Petri nets provide an elegant solution to the given combinatorial
problem by pattern compression of the repeated parts of a Petri net, while main-
taining the connections between those parts. Each repeated component is as-
sociated with a unique integer (‘colour’); see Methods section for details. This
colouring principle can be equally applied to SPN or CPN , yielding coloured
SPN (SPN C) and coloured CPN (CPN C).

In summary, Figure 3 gives the same model in two different but equivalent
representations, uncoloured (Top) and coloured (Bottom), which also means that
both generate the same ODEs. Obtaining the coloured model from the uncoloured
one is called folding, and the reverse operation is called unfolding. Folding is
typically performed manually because the degree of folding is subjective, while
unfolding can be done automatically as long as all colour sets are discrete and
finite.

Increasing the number of strata while ensuring that all needed connectivities
are present just requires extending the colour set Strata; nothing else in the
structure of the coloured model needs to be touched, apart from adjusting the
initial marking. In this way, our modelling approach supports scalability in an
easy to use manner. In general the unfolded SIR model for s strata comprises 3s
places, s2 + s transitions and 4s2 + 2s arcs, and the ODEs generated consist of
3s equations.

30 March 2021 6
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CPI, two P-invariants, one for each strata
not CTI, no T-invariants 

  PUR   ORD   HOM   NBM   CSV   SCF   FT0   TF0   FP0   PF0   CON   SC    NC  
   N     N     Y     N     Y     N     Y     Y     N     N     Y     N   nES 
 RKTH   STP   CPI   CTI  SCTI    SB   k-B   1-B   DCF   DSt   DTr   LIV   REV 
   -     N     Y     N     N     Y     Y     N     -     -     -     N     N  

Infectious_Young
10

Recovered_Young

Susceptible_Young
50,000 �

Susceptible_Old
50,000 �

Recovered_OldInfectious_Old

InfectYoung

RecoverYoung

RecoverOld

InfectOld

OldInfectYoung

YoungInfectOld

2

2

Infectious

10

10`young
Strata

Recovered
Strata

Susceptible

100,000 ��

50000`young++
50000`old

Strata

Infect Recover

x xxx++y

y

1010,000

5,000

22

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

2

Figure 3: SIR-Sage
2;20 models. Two variations of the SIR model describing strat-

ification of a population into two age groups (young and old) or 20 age groups,
and the cross infections between the groups. Transmission of infection does not
change the age group of the infectious person. At the start there are no old infec-
tious people, and only very few young infectious people. (Top) CPN for two age
strata, each of which is associated with a separate, but structurally identical SIR
model, and linked by cross infections. (Middle) The same model represented
as a coloured CPN . The markings of coloured places always show the sum of
the markings of the corresponding uncoloured places. The colour definitions are
given in the Methods section, and the ODEs in the Supplementary Material.
(Bottom) Unfolded CPN of a 20-strata SIR model, with coloured graphics.
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2.4 Pandemic models

The distinguishing characteristic of a pandemic model is the concept of multiple
intercommunicating epidemic models in a spatial (geographic) context. In the
following we prefix standard epidemic model names by ‘P’ for pandemic, thus
obtaining PSIR, PSIQR, etc.

Two countries, linked by travel. Figure 4 (Top) shows a PSIR model com-
prising epidemic SIR models in each of two countries, with population movement
permitted between the countries for all compartments. As for the age strata
model, we can fold it into a coloured version (Figure 4 (Bottom)). The process
of colouring is very similar to that described for SIR-Sage

2 (see Methods section).

N countries, linked by travel. Generalising this idea to more than two coun-
tries, the travel connectivities between countries need to be defined. For example
when considering surface travel, not all countries are directly connected to each
other. We assume that the connectivity is described by a graph (Figure 5 (Top
left)); this could be directly encoded as a standard Petri net (Figure 5 (Top mid-
dle)), which we fold for convenience into a coloured Petri net (Figure 5 (Top
right)), see Methods section for details. Equally the graph could include air
and/or sea connections; even then, connectivity could still be less than fully con-
nected.

The coloured Petri net representation of the PSIR over four countries (Fig-
ure 5 (Middle)) is derived by adjusting the colour definitions in the SIR for two
countries (Figure 4 (Bottom)) according to the connectivity graph, and getting
the initial marking right.

The generalisation to connectivity graphs representing different geographical
relationships is straightforward, merely requiring adjusting the two related colour
definitions (Countries, Connections) and the initial marking. This example illus-
trates how our modelling approach supports reusability in an easy to use manner.
In general the unfolded PSIR model for n countries with overall m mutual con-
nections comprises 3n places, 2n + 6m transitions and 6n + 12m arcs, and the
ODEs generated consist of 3n equations.

We provide a number of PSIR pandemic models in the Supplementary Mate-
rial, including Europe (P10SIR – 10 countries, 15 mutual connections, P48SIR –
48 countries, 85 mutual connections), China (PChinaSIR – 34 provinces, 71 mu-
tual connections) and the USA (PUSASIR – 50 states, 105 connections), and the
guidelines how to obtain the corresponding ODEs using our tool platform.

30 March 2021 8



From Epidemic to Pandemic Modelling

S_DE

83,000 �
R_DEI_DE

10

S_FR
67,000 �

R_FRI_FR

RecoverDEInfectDE

RecoverFRInfectFR

S_DEtoFR

S_FRtoDE

I_DEtoFR

I_FRtoDE

R_DEtoFR

R_FRtoDE

2

2

S
150,000 ��

83000`DE++
67000`FR

Countries

R
Countries

I
10

10`DE
Countries

RecoverInfect

S_travel [x != y] I_travel [x != y] R_travel [x != y]

x

2`x x xx

x

y
x
y

x
y

Figure 4: P2SIR model. (Top) CPN for two countries, each of which is associ-
ated with a separate, but structurally identical SIR model, and linked by travel.
(Bottom) The same model represented as a coloured CPN . Eeach travel tran-
sition is associated with a guard [x != y] (x and y are unequal) to ensure that
travellers do not immediately return to their country of origin. The uncoloured
and coloured model are equivalent, thus generate the same ODEs, which are given
in the Supplementary Material.

2.5 Combined models

These three extensions – SIR variations, stratification and space – are orthogonal,
and thus any combination is possible. For illustration we provide two examples:

• P10SIQR combining space (Europe with 10 countries) with an extended
epidemic model (see Figure C.3) which yields 4n = 40 ODEs, and

• P48SIR-Sage
10 combining space (Europe with 48 countries) and stratification

(10 age strata per country; coloured version in Figure 5 (Bottom), unfolded
version in Figure 6) which yields 1440 ODEs.
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country

Countries
travel

[connected(x,y)]

x
y

Infectious

10

10`DE
Countries

Susceptible

208,500 ��67000`FR++
11500`BE++
83000`DE++
47000`ES

Countries
Recovered
Countries

Infect Recover

I_travel
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S_travel
[connected(x,y)]

R_travel
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x
y

x

2`x x

x

y

x

x
y

x

Infectious

4,800 �

10`all()
CountryStrata

Recovered
CountryStrata

Susceptible

4,800,000 ��

10000`all()
CountryStrata

Infect Recover

S_travel
[connected(x,y)]

I_travel
[connected(x,y)]

R_travel
[connected(x,y)]

(x,a)
(y,a)

(x,b)

(x,a)++
(x,b)

(x,a)

(x,a)

(y,a)

(x,a)(x,a)

(x,a)
(y,a)

Figure 5: PnSIR models. (Top left) Connectivity graph for four countries.
(Top middle) Petri net representation of the connectivity graph. (Top right)
Coloured Petri net representation of the connectivity graph; see Methods section
for details. (Middle) Coloured Petri net representation of the pandemic P4SIR;
structural identical with P2SIR in Figure 4 (Bottom); both CPN C differ by their
colour definitions encoding different connectivity graphs. The unfolded Petri net
of P4SIR is give in Figure C.2. (Bottom) P48SIR-Sage

10 coloured Petri net for 48
countries in Europe, each with 10 age strata, see Figure 6 for its unfolded version.

In general the unfolding of a PnSIR-Ss model with s strata and n countries
withmmutual connections comprises 3sn places, n(s2+s)+6ms transitions
and 2n(2s2 + s) + 12ms arcs.
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Figure 6: P48SIR-S
age
10 model. (Top left) Map of 48 European countries cre-

ated with https://mapchart.net. (Top right) Undirected graph representa-
tion of the map where edges represent two-way surface connections. Blue edges
stand for road connections, orange dashed edges for sea connections. (Bottom)
Unfolded version of the coloured net in Figure 5 (Bottom); layout automatically
generated. Iceland appears as an isolated subnet because it is not connected by
surface to the rest of Europe, and is thus similar to the SIR net with 20 strata in
Figure 3 (Bottom). Model size: 1,440 places; 10,380 transitions.
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2.6 Parameter fitting

Apart from defining the structure of a model, it is also important to find suitable
rate constants. This can be naively achieved by scanning over parameter val-
ues, or in a more sophisticated manner heuristically by target driven parameter
optimisation.

Even without fitted values derived from real world data, a great deal of use-
ful analysis can be achieved using comparative rate constant values. Examples
include scanning by

• varying the ratio between infection rate and recovery rate while maintaining
the recovery rate constant resulting in changes in the Rt value (SIR), and
comparison between geographic regions (PSIR),

• varying the ratio between direct and quarantine recovery (SIQR), and
varying quarantine regimes (Figures C.4, C.5, both referring to the model
P10SIQR in Figure C.3 (Top)).

• varying the initial state of the infectious compartments in the different
countries of a pandemic model (PSIR),

• varying the strength of the connectivities between countries - road, train,
sea and air - in a pandemic model (PSIR).

Refining a model automatically involves increasing the number of required
kinetic rate constants. Specifically in the SIR-Sage

2 model, the kinetic constants
can be different for both intra-stratum and inter-strata transitions. This can
be achieved in the coloured version using colour-dependent rates, see Methods
section.

More generally, we can establish equivalence classes for rate constants, for
example in a PSIR travel model, there can be different rate constants between
classes of movements such as road versus air and/or frequent versus rare, while
the rate constants within classes are the same.

When real world data are available, then we can attempt to fit models to them.
We did this for the pandemic model for ten European countries (P10SIR, see
Figure C.6), based on source data for daily new infections obtained from World-
Ometers (https://www.worldometers.info/coronavirus/) during the period
19th January to 16th August 2020. The rate constants fitted were for infection,
and the inter-country movement for all three compartments. The values for the
Susceptible, Infectious and Recovered compartments for movement in one direc-
tion between a pair of countries were kept the same, thus reflecting the assumption
that the rate constant for travel does not depend on the compartment, but only on
the journey. Initial markings for Infectious were set at 1% of the total population
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for each country according to Wikipedia, divided by 1000. Daily new cases were
standardised and smoothed using a 7-day rolling average (Figure C.7) and the
magnitude and timing of the peaks were detected computationally (Table C.1).

The goals of the fitting were (Objective 1) to reproduce the order of the time
taken from the first 5 deaths to a peak for daily new cases, (Objective 2) to repro-
duce the order of the height of the peaks for daily new cases, and (Objective 3)
combining Objective 1 and Objective 2. Fitting was performed in all three cases
using target driven optimisation employing Random Restart Hill Climbing (see
Methods section for details, and Tables C.2 – C.5).

2.7 Analysis

For an initial validation of (unfitted) pandemic model behaviour we performed
correlation analyses between real world variables and model variables for P10SIR
and P48SIR; for details see Table C.6 and Figures C.10, C.12. These results
support our assumption that even the unfitted pandemic models behave well,
and that the geography incorporated into the model appropriately influences be-
haviour. Thus, an analysis of the unfitted pandemic PSIR model can give useful
insights even in the absence of detailed real data; specifically given the geograph-
ical connections between regions and their populations, we can predict to some
extend the expected peak height of infections and thus inform planners how to
cope with the impact on health services etc.; some examples are given below.

An initial analysis can be performed by inspection of the visualised time series
plots. Properties of interest include the values of Susceptible and Recovered over
time (e.g. for herd immunity), and the existence, order and height of peaks for
Infectious, see e.g. Figure C.8. This can be extended to derived measures such as
the R value, computed over time and plotted for the different geographic regions.

Going beyond visual inspection, the order and height of peaks can be as-
certained computationally from the traces. More generally, many behavioural
properties of interest can be expressed using linear temporal logic and analysed
in practice via simulative model checking [DG08,GHGC19], which is specifically
useful for exploring larger models by the use of property libraries, see Methods
section and Figure C.9.

In addition, the general relationships between the behaviour of related com-
partments or derived measures in different geographical regions can be determined
via cluster analysis. The results for hierarchical clustering can be represented for
example via dendrograms, see Figures C.13, C.14.

Furthermore, the results of such comparative analyses above could be related
to the genomic data of the causative infectious agent, for example a virus which
exhibits high mutation rates. Thus the variants or strains of the virus which
evolve over the time of an epidemic can be related to the behaviour of pandemic

30 March 2021 13
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models.
Finally, pandemic models can be used to predict the effects of various control

measures. These include travel restrictions in terms of inter-country connections,
and quarantine restrictions on international travellers. In addition, the effects
of the imposition and lifting of lockdowns in different regions and at different
times can be investigated, but requires the dynamic variation of rate constants
during simulation. In order to facilitate this, we have recently extended the Spike
simulator to include event-driven triggers, which enables the modelling of these
control measures, see for example Figure C.16.

Given a pandemic PSIR model with fitted parameters, as developed in the pre-
vious section, we can perform a detailed comparative analysis over the geographic
regions, going beyond the analysis based on comparative values;

3 Methods
Related work. In order to put our work in context, we give a brief overview of
related work. A general review paper on epidemic modelling including metapop-
ulation models can be found in [Bra17]. Early basic pandemic approaches in-
clude mathematical models based on ODEs for the global spread diseases, where
travel connectivity is described by adjacency matrices [RLJ85, LJ88], and by
graphs [SP93,SD95].

The GLEaMviz computational tool [VdBGG+11] has been developed to model
multiscale mobility networks and the spatial spreading of infectious diseases build-
ing on a series of papers including [CV08,BCG+09,BGH+10] and has been used
to model the 2009 H1N1 pandemic [BPR+11]. Some more recent work by other
groups includes [CYX14] considering dynamics of a two-city SIR epidemic model
and [ABCC+20,GS20] for the current COVID19 pandemic.

The Spatiotemporal Epidemiologic Modeler (STEM) is an Eclipse based
monolithic framework to support the development and simulation of geographic
disease models [EDK10]. It builds on a component-based architecture (plugins);
models can be simulatated deterministically or stochastically. Models are en-
coded in Java, and it is not obvious how to export a model if one wants to apply
any analysis technique not supported by the framework.

Age-based stratification has been addressed in, for example, [DVHC13,BM20],
and the effects of intervention strategies for COVID19 in [BM20, PLR+20,
GBB+20].

Other approaches besides ODE modelling include stochastic models [NA19,
OWZ20], agent based models [MAS+20] and coloured Petri nets [CPG+20].

In the following we describe the methods underlying our technology.
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3.1 Modelling

SIR modelling assumptions. The population in the SIR model population is
divided into three compartments – Susceptible (S), Infectious (I) and Recovered
(R). These three compartments are considered to be homogeneous, thus there is
an equal probability of any event occurring to any member of each compartment.
In general, this assumption of homogeneity applies to any compartment in our
models.

A susceptible person is infected by an infectious person so that they are both
infectious; thus getting infected and becoming infectious coincide. A susceptible
person can become recovered. Recovered people are resistant and cannot become
susceptible or infectious. This simple model does not consider births, or natural
deaths so that the total population size is constant, as can be seen from the
structure of the SIR model in Figure 1, which shows a conservative Petri net
covered by a single minimal P-invariant (compare paragraph below on Petri net
analysis techniques). It is also generally assumed that S0 � I0, and (for obvious
reasons) I0 > 0 and R0 = 0.

Petri nets are a family of formal languages which come with a graphical repre-
sentation as bipartite directed multi-graphs, enjoying an operational (execution)
semantics. They can be either untimed and qualitative, or timed and quantitive;
for details see [HGD08]. All these net classes share the following graph properties.

• Bipartite: There are two types of nodes, called places and transitions, which
form disjunctive node sets. Places, graphically represented as circles, typi-
cally model passive objects (here compartments and derived measures, pos-
sibly in different locations), while transitions, graphically represented as
squares, model active events (such as infect, recover, travel), changing the
state of the passive nodes.

• Directed: Directed arcs, represented as arrows, connect places with transi-
tions and vice versa, thereby specifying the relationship between the passive
and active nodes. The bipartite property precludes arcs between nodes of
the same type.

• Multigraph: Two given nodes may be connected by multiple arcs, typically
abbreviated to one weighted arc. The weight is shown as a natural number
next to the arc. The default value is 1, and usually not explicitly given.

The execution semantics builds on movable objects, represented as tokens
residing on places. The number zero is the default value, and usually not explicitly
given. The current state (marking m) of a model is defined by the token situation
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on all places, usually given by a place vector, which is a vector with as many
entries as we have places, and the entries are indexed by the places. The initial
state is denoted by m0.

The specific details of the execution semantics slightly differ for qualitative
and quantitative Petri nets, and if the Petri net class belongs to the discrete or
continuous modelling paradigm.

We start off with standard Petri nets, which are inherently untimed and dis-
crete. Their (non-negative integer) token numbers are given by black dots or
natural numbers. The current state is given by the number of tokens on all
places, forming a place vector of natural numbers. The (integer) arc weights
specify how many of these tokens on a certain place are consumed or produced
by a transition, causing the movement of tokens through the net, which happens
according to the following rules (see [BHM15]):

• Enabledness: A transition is enabled, if its pre-places host sufficient amounts
of tokens according to the weights of the transition’s ingoing arcs. An
enabled transition may fire (occur), but is not forced to do so.

• Firing: Upon firing, a transition consumes tokens from its pre-places ac-
cording to the arc weight of the ingoing arcs, and produces new tokens on
its post-places according to the arc weights of the outgoing arcs. The firing
happens atomically (i.e., there are no states in between) and does note con-
sume any time. Firing generally changes the current distribution of tokens;
thus the system reaches a new state.

• Behaviour: We obtain the dynamic behaviour of a Petri net by repeating
these steps of looking for enabled transitions and randomly choosing one
single transition among the enabled ones to let it fire.

Rate functions. These standard untimed Petri nets, which are entirely quali-
tative, can be extended by enriching transitions with firing rate functions. We
obtain timed and thus quantitive Petri nets, out of which we use in this paper
stochastic Petri nets (SPN ) generating continuous time Markov chains, and con-
tinuous Petri nets (CPN ) generating Ordinary Differential Equations (ODEs).
Both net classes merely differ by the interpretation of the rate functions; thus
SPN and CPN , sharing the same net structure, can be easily converted into
each other.

Rate functions are, technically speaking, arbitrary mathematical functions,
typically depend on the given state, and are often governed by popular kinetics,
such as mass action kinetics [WW45].
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Stochastic rate functions specify how often a transition occurs per time unit,
technically achieved by stochastic waiting times before an enabled transition ac-
tually fires. SPN with exponentially distributed waiting times for all transitions
fulfil the Markov property; thus their semantics are described by continuous time
Markov chains (CTMC), and the current state of an SPN is still defined by a place
vector of natural numbers. The CTMC for a given SPN is basically isomorphic
to the state transition system of its corresponding untimed Petri net. Thus, all
Petri net analysis techniques see paragraph on Petri net analysis below) can still
be applied, and all behavioural properties that hold for the untimed Petri net are
still valid for the corresponding SPN .

In contrast, deterministic rate functions define the strength of a continuous
flow, turning the traditionally discrete modelling paradigm of Petri nets into a
continuous one: the discrete number of tokens on each place is replaced by a
(non-negative) real number, called token value. Thus, the current state of a
CPN is defined by a place vector of real numbers. A CPN transition is enabled
if the token value of all its pre-places is larger than zero. This coincides for mass
action kinetics with transition rates larger than zero. Due to the influence of
time, a continuous transition is forced to fire as soon as possible. Altogether, the
semantics of a CPN is defined by ODEs.

How to transform a CPN into ODEs. Each place subject to changes gets
its own equation, describing the continuous change over time of its token value
by the continuous increase of its pre-transitions’ flow and the continuous decrease
by its post-transitions’ flow. Thus, in the generated ODEs, places are interpreted
as (nonnegative) real variables. A transition that is pre- and post-transition for a
given place yields two terms, which can be reduced by algebraically transforming
the right-hand side of the equation. Thus, each equation corresponds basically
to a line in the incidence matrix [HGD08].

To formalise the transformation of CPN into ODEs, we need to introduce a
few technical notations. Let •p denote the set of pre-transitions of the place p,
and p • the set of post-transitions, v (t) gives the rate function for transition t,
f (t, p) the weight of the arc going from t to p, and f (p, t) the weight of the arc
going from p to t. Then the ODE generated for the place p is given by Equation 2.

d (p)

dt
=

∑
t∈•p

f (t, p) v (t)−
∑
t∈p •

f (p, t) v (t) (2)

In words: the pre-transitions t ∈ •p increase the token value of p, thus their
weighted rate functions occur as plus terms, while the post-transitions t ∈ p •

decrease the token value of p, thus their weighted rate functions occur as minus
terms of the ODE’s right hand side.
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The models presented in this paper always generate as many ODEs of this
style as we have places. This is automatically triggered when simulating a CPN ,
which can be done in our platform either with Snoopy or Spike. In summary,
CPN can be seen as a structured approach to write ODEs [BGHO08]; they
uniquely define ODEs, but generally not vice versa, compare [SH10,HG11].

Coloured Petri nets combine Petri nets with the powerful concept of data
types as known from programming languages [GL81, JK09]. Tokens are distin-
guished via colours; there are no limits for their interpretation. For example,
colour allows for the discrimination of compartments by, e.g., age strata or gen-
der, or to distinguish compartments in different geographical locations. In short,
colours permit us to describe similar network structures in a compressed, but
still readable way. A group of similar model components (subnets) is repre-
sented by one component coloured with an appropriate colour set, and the in-
dividual components become distinguishable by a specific colour in this colour
set. See [LHG19] for a review of the widespread use of coloured Petri nets for
multilevel, multiscale, and multidimensional modelling of biological systems.

Coloured Petri nets consist, as uncoloured Petri nets, of places, transitions,
and arcs. Additionally, a coloured Petri net is characterised by a set of discrete
data types, called colour sets, and related net inscriptions.

• Places get assigned a colour set and may contain a multiset of distinguish-
able tokens coloured with colours of this colour set. Our PetriNuts platform
supports a rich choice of data types for colour set definitions, including sim-
ple types (dot, integer, string, boolean, enumeration) and product types.

• Transitions get assigned a guard, which is a Boolean expression over vari-
ables, constants and colour functions. The guard must be evaluated to true
for the enabling of the transition. The trivial guard true is usually not
explicitly given.

• Arcs get assigned an expression; the result type of this expression is a
multiset over the colour set of the connected place.

• Rate functions may incorporate predicates, which are again Boolean expres-
sions. They permit us to assign different rate functions for different colours
(colour-dependent rates). Otherwise, the trivial predicate true is used; for
examples see Supplementary Material.

Elaborating the behaviour of a coloured Petri net involves the following no-
tions (see [BHM15]).
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• Transition instance: The variables associated with a transition consist of
the variables in the guard of the transition and in the expressions of adjacent
arcs. For the evaluations of guards and expressions, values of the associated
colour sets have to be assigned to all transition variables, which is called
binding. A specific binding of the transition variables corresponds to a
transition instance. Transition instances may have individual rate functions.

• Enabling: Enabling and firing of a transition instance are based on the
evaluation of its guard and arc expressions. If the guard is evaluated to
true and the pre-places have sufficient and appropriately coloured tokens,
the transition instance is enabled and may fire. In the case of quantitative
nets, the rate function belonging to the transition instance is determined
by evaluating the predicates in the rate function definition.

• Firing: When a transition instance fires, it consumes coloured tokens from
its pre-places and produces coloured tokens on its post-places, both accord-
ing to the arc expressions. which generally results into a new state.

Colouring example. Let us illustrate the use of colour by means of the stratified
age SIR example (SIR-Sage

2 ), see Figure 3. The common pattern is a single basic
SIR model. In order to design the coloured model, shown in Figure 3 (Bottom),
we introduce an enumerated colour set Strata = {young, old} (where each
element is internally mapped onto an integer) and two variables of this colour set
x and y, each of which can hold either young or old. Arcs in this model are now
labelled with expressions over these variables. The bindings to the variables are
considered only in the local environment (incoming and outgoing arcs) of each
transition. The incoming and outgoing arcs of the coloured transition Recover
are both labelled with the same variable x because that transition only operates
within one stratum. However the coloured transition Infect has connections both
within one stratum and between strata; this is accomplished by using the two
variables x and y on the two incoming arcs from Susceptible and Infectious, each
of which independently hold as bindings either young or old, giving in total
four combinations, two of which standing for the inter-strata cross infections and
the other two for the intra-stratum infections. The x represents the person who
becomes infectious, and y the infecting person. Thus the outgoing arc from the
transition to the place Infectious is labelled with the multiset {x,y} written as
x++y. If x and y hold the same colour, x++y corresponds to an arc weight of
2 in the standard Petri net model.

Folding/Unfolding. Any (standard) Petri net can be folded into a coloured Petri
net comprising just a single (coloured) place and a single (coloured) transition.
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Then, the entire structure is hidden in the colour definitions, which can always
be revealed by automatic unfolding. Generally, the decision regarding how much
structure to fold into colours is a matter of taste. We follow the rule that a model
should be still completely comprehensible by reading the structure and its colour
annotations. In general, folding of epidemic models should preserve the pattern
of the SIR (or related) model. For illustration, we provide a coloured version of
the SIAR symptomatic/asymptomatic model in the Supplementary Material.

In principle, coloured Petri nets could be simulated directly on the coloured
level, thus avoiding blowing up the model structure which often comes with un-
folding. However, the corresponding algorithms are much more complicated, often
involve an implicit partial unfolding, and only a few of them are actually available
in practice [BFF+15].

In contrast, unfolding to the corresponding uncoloured Petri net can be effi-
ciently achieved [SRL+20] and permits to re-use the rich choice of analysis and
simulation techniques, which have been developed over the years for uncoloured
Petri nets, including SPN and CPN , many of them are now supported by highly
efficient libraries and reliable software tools.

This is why we exclusively adopt the second approach. All our coloured models
are automatically unfolded when it comes to analysing and/or simulating them.

Encoding space and locality. The use of colour enables us to encode matri-
ces, where colours (natural numbers) represent indices; multidimensional ma-
trices can be represented by appropriate colour tuples. Previously we have
used this approach to encode one, two and three dimensional Cartesian space
where coordinates were represented as tuples over the entire matrix [GHLS13],
for example modelling diffusion and cell movement in biological systems: pla-
nar cell polarity in the Drosophila wing [GGH+13], phase variation in bacterial
colonies [PGH+15], bacterial quorum sensing [GHGC19] and intra-cellular cal-
cium dynamics [IHAH20].

In this research we use tuples to index sub-matrices, permitting us to rep-
resent graphs as adjacency matrices and hence to encode geographical spatial
relationships. This overcomes the limitations of the previous Cartesian coor-
dinate approach for representing pandemics, because whole matrices represent
travel diffusion-wise in a regular grid, rather than specific travel connections.

For illustration we consider the encoding of the connectivity graph for four
European countries, see Figure 5 (Top). In order to achieve this we define a
colour set of enumeration type comprising all countries and next a matrix as a
product over this colour set.
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colorsets:
enum Countries = {BE,DE,ES,FR};
Matrix = PROD(Countries,Countries);

A subset of the matrix is defined by a Boolean expression (given in square
brackets) comprising all required connections.

colorsets:
Connections = Matrix[ // subset defined by Boolean expression

(x=ES & (y=FR)) |
(x=FR & (y=ES | y=BE | y=DE)) |
(x=BE & (y=DE | y=FR)) |
(x=DE & (y=FR | y=BE ))];

Finally we define a colour function connected to be used as guard for the
Travel transitions, which constrains travel according to the connectivity graph.

colorfunctions:
bool connected(Countries p, Countries q) { (p,q) elemOf Connections };

This acts in the same way as the more simple constraint [x != y] used in Fig-
ure 4. Now, colour-dependent rates may model different disease control policies
in different subpopulations or in different locations.

Besides this, we need two variables of the colour set Countries to be used in
the arc inscriptions and thus occurring as parameters in the transition guard.

variables:
Countries : x;
Countries : y;

Framework. These colouring principles can be equally applied to qualitative
and quantitative Petri nets, yielding, among others, coloured SPN (SPN C) and
coloured CPN (CPN C): Our PetriNuts platform supports the handling of all of
them, which includes the reading of a quantitative Petri net as either SPN or
CPN (supported by Snoopy and Spike) and the automatic unfolding of SPN C
and CPN C to their uncoloured counterparts (supported by Snoopy , Marcie and
Spike).

See Figure A.1 for an overview of the modelling paradigms integrated in the
unifying framework of the PetriNuts platform and the relations among the sup-
ported net classes [HHL+12].
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Petri net analysis techniques. Petri net theory comes with a wealth of anal-
ysis techniques [Mur89], some of them are particularly useful in the given context
due to the specificity of the net structures of our SPN /CPN models, which we
obtain by design.

• Conservative: A Petri net is called conservative, if the number of tokens
is preserved by any transition firing. This is the case if it holds for all
transitions that the sum of the weights of incoming arcs equals the sum
of the weights of outgoing arcs. In our models, most of the transitions
have exactly one incoming and one outgoing arc, with the exception of
Infect transitions which have two incoming and two outgoing arcs (the latter
combined to one arc with a weight of 2).

• P-invariant: A P-invariant (as it occurs in the models considered here) cor-
responds to a set of places, holding in total the same amount of tokens in
any reachable state. Generally, P-invariants induce token-preserving sub-
nets. A P-invariant is minimal, if (roughly speaking) it does not contain a
smaller P-invariant; see [Hei09] for details. The models discussed in this pa-
per have the remarkable property that the are covered by non-overlapping
minimal P-invariants, and each minimal P-invariant comprises the places
(compartments) of one stratum.

Extending a model by cumulative counters, such as the total number of
infectious over time, destroys the conservative net structure and induces
additional overlapping P-invariants; thus the model is still covered with
P-invariants (CPI); see Figure C.3 for an example.

More generally speaking, any epidemic/pandemic model without birth
(transition without pre-place) and/or death (transition without post-place)
is covered with P-invariants.

We use both criteria for model validation to avoid modelling mistakes. They
are independent of the initial marking and can be decided by exploring the net
structure only. This is done in our PetriNuts platform by the tool Charlie. Both
criteria prove independently the boundedness of a model (the number of tokens
on each place is limited by a constant), which ensures in turn a finite state space.

The finite state space could possibly open the door to analyse SPN models
by numerical methods to determine popular Markov properties [SH09], such as
the probability to reach a (transient) state where, e.g., half of the population is
effected. A closer look on the typical size of the generated CTMC however soon
questions this endeavour, as numerical methods rely on a real-numbered square
matrix in the size of the state space [HRSS10]. So we basically have to confine
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ourselves to simulation and analysis techniques working over simulation traces,
such as simulative model checking; see Methods subsection on Analytical methods.

It is obvious from exploring the model behaviours that they reach a dead state
(there is no enabled transition), as soon as the infectious compartment becomes
empty, because there is no way to add something to the infectious compartment
as soon as it got empty. In Petri net terms this corresponds to a bad siphon
(a siphon not containing a trap); all these are further popular notions of Petri
net theory, requiring structural analysis only, while permitting conclusions on
behavioural properties; see [HGD08] for details.

Often, epidemic/pandemic models are by design irreversible, reflecting the
(optimistic) assumption that a once gained immunity is never lost, and a model
will reach a dead state at the very latest when the entire population is recovered.
Loosening this assumption by adding a transition from either Infectious or Re-
covered to Susceptible and refilling Infectious in each epidemic model component
will introduce cycles to a model which now becomes a chance to be reversible
and live (which in turn precludes dead states), if it is covered with T-invariants
(see [Hei09] for details). This obviously requires that the geographical connectiv-
ity graph is strongly connected.

Petri net simulation. Besides structural analysis for model validation, we
apply simulation techniques generating traces of model behaviour. Simulation
traces are time series reporting the current variable values at the n + 1 time
points ti of a specified output grid i = 0, . . . n, typically splitting the simulation
time into n equally sized time intervals. We consider here two basic types of
traces:

• traces of place markings, i.e., time series of the current marking (state) of
the compartments at the specified time points of the simulation run:

s(ti) : P → N, with s(t0) = m0,

i.e., s(ti) are (non-negative) integer place vectors over all place markings,
indexed by the set of places P .

• traces of transition rates, i.e., time series of the number of occurrences which
each individual event had in total in the latest time interval,

v(ti) : T → N, with v(t0) = 0,

i.e., v(ti) are (non-negative) integer transition vectors over all transition
rates, indexed by the set of transitions T .
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Reading a transition rate vector as Parikh vector immediately leads us to the
state equation specifying the relation between both traces:

s(ti) = s(ti−1) + C · v(ti), i = 1 . . . n,
where C is the incidence matrix of a Petri net (see [HGD08]). Thus, the place
trace can be derived from the transition trace, but generally not vice versa. In
the stochastic setting, the transition trace cannot be uniquely deduced from the
place trace due to alternative and parallel transitions, which specifically holds
for individual traces. Therefore, we directly record the transition traces during
simulation.

Often we consider averaged traces , and the deterministic simulation of
CPN/CPN C is bound to do so, such that the individual values at each time
point are non-negative real numbers (R+) instead of natural numbers (N):

s(ti) : P → R+, with s(t0) = m0 (traces of place markings),
v(ti) : T → R+, with v(t0) = 0 (traces of transition rates).
Simulation traces may include coloured places/transitions, where a coloured

node always gives the sum of the values of the corresponding unfolded nodes.
For example, in the SIR-S2 model given in Figure 3, the coloured place Suscep-
tible always shows the sum of its two unfolded nodes Susceptible_Young and
Susceptible_Old ; likewise for transitions and their rates.

Derived measures. A measure often used in the daily news is the daily or
weekly number of new infections, given at time point t by

∆I1
t = St − St−1 or ∆I7

t = St − St−7 .

These can also be defined by:

∆I1
t = (It − It−1) + (Rt −Rt−1) or ∆I7

t = (It − It−7) + (Rt −Rt−7) .

These numbers are typically normalised to a specific population size, e.g.,
100,000, thus permitting the comparison of the local incidence numbers among
regions.

A more scientific measure for characterising the progress of an epidemic is
the reproduction number R [HSW05, vdD17] which is the average number of
secondary cases produced by one infectious individual introduced into a popula-
tion of susceptible individuals. It allows modellers to work out the extent of the
spread, but not the rate at which the infection grows [Ada20]. This measure has
several interpretations. R0 assumes that everybody in a population is susceptible
to infection; this is only true when a new virus is introduced into a population
which has never experienced it before and is a measure of the potential viru-
lence of the disease. Rt (sometimes called Re, or ‘effective R’), is calculated over
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time as an epidemic progresses, and is a measure of the potential virulence of
the disease. The value of Rt varies during the course of an epidemic, as people
gain immunity after an infection or a vaccination, or have adjusted their social
interactions. Thus generally it holds that Rt ≤ R0.

In our SIR model, we calculate Rt for a time window of 1 by Equation 3; the
generalisation to wider time windows is straightforward.

Rt = ∆I1
t /∆I1

t−1 (3)

Rt = (St − St−1)/(St−1 − St−2)

Rt = ((It − It−1) + (Rt −Rt−1))/((It−1 − It−2) + (Rt−1 −Rt−2))

Naming convention. The naming convention of our models basically follows
this Extended BNF. For a summary of the models provided see Table 1.

ModelName ::= [PandemicComponent] EpidemicComponent [‘-’ StratifiedComponent]
PandemicComponent ::= ‘P’ [Parameter] [PandemicRest]
PandemicRest ::= ‘Q’
Parameter ::= Number | Country
Country ::= ‘USA’ | ‘China’
EpidemicComponent ::= ‘S’ ‘I’ [EpidemicOption] ‘R’
EpidemicOption ::= ‘A’ | ‘V’ | ‘Q’
StratifiedComponent ::= ‘S’ {StratificationParameter}+

StratificationParameter ::= Type Number
Types ::= age | gender | ε

3.2 Parameter fitting

Random Restart Hill Climbing (RRHC). There are two types of optimi-
sation which are systematic and local search [RN13]. Systematic approaches store
information about the path to the target, whereas local searches do not retain
such information. Local searches have two key advantages: (1) they use very lit-
tle memory due to not storing the path, and (2): they can often find reasonable
solutions in large state spaces [RN13].

One type of local search algorithm is the Hill-Climbing algorithm (HCA). This
algorithm generates a random solution and makes small changes to the solution
to increase the fit to target data. The HCA is greedy as it only accepts a solution
better than its current state. As a result, the HCA can get stuck firstly, in a local
maximum, which is a peak higher than each of its neighbours but lower than the
global maximum; secondly, in a flat local maximum, which is a local maximum
that has many solutions and is difficult for the algorithm to navigate; and finally,
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Table 1: Summary table of models. I Basic and extended epidemic models. II
Stratified models. III Pandemic models. IV Combined models; CANDL files
provided as separate files in Supplementary Material.

Type Id Long name Reference
I SIR standard SIR model Figure 1

SIVR SIR with disease variant Figure C.1
SIQR SIR with local quarantine Figure 2 (Top)
SIAR SIR with asymptomatic infectious Figure 2 (Bottom)

II SIR-S Stratified SIR
SIR-Sage

2 Stratified SIR, 2 age strata Figure 3 (Top/Middle)
SIR-S10 Stratified SIR, 10 age strata
SIR-Sage

20 Stratified SIR, 20 age strata Figure 3 (Bottom)
SIR-Sage,gender

10x2 Stratified SIR, 10 age and 2 gender strata
III PSIR Pandemic SIR

PnSIR Pandemic SIR, n locations Figure 4:(n=2), Figure 5:(n=4)
P10SIR Pandemic SIR with CummulativeInfectious,

Western Europe (10 countries, 15 mutual con-
nections)

Figure C.6, P10SIR.candl

P48SIR Pandemic SIR for Europe (48 countries, 85
mutual connections)

P48SIR.candl

PChinaSIR Pandemic SIR for China (34 provinces, 71 mu-
tual connections)

PchinaSIR.candl

PUSASIR Pandemic SIR for USA (50 states, 105 connec-
tions)

PusaSIR.candl

IV P48SIR-Sage
10 Pandemic SIR, Europe, 10 age strata Figure 5 (Bottom), Figure 6

P10QISIR Pandemic SIR with may-quarantine on arrival
for Infectious, Western Europe

Figure C.3 (Top)

P10QSIR Pandemic SIR with must-quarantine on arrival
for all compartments, Western Europe

Figure C.3 (Bottom)

at a shoulder, which is a flat region of space that is neither a local or global
maximum [RN13]. To overcome such sticking points the HCA can be modified
into a stochastic Random-Restart Hill-Climbing algorithm (RRHCA) by defining
a number of times to re-run the whole program. The final solution is the best of
all runs.

The goals of the fitting were (Objective 1) to reproduce the order of the time
taken from the first 5 deaths to a peak for daily new cases, (Objective 2) to
reproduce the order of the height of the peaks for daily new cases, and (Objec-
tive 3) combining Objective 1 and Objective 2. Fitting was performed in all three
cases using target driven optimisation employing Random Restart Hill Climbing.
RRHC was used for parameter optimisation with code developed in Python which
called Spike. This Python program automatically optimises input parameters to
better represent the target data. Using this approach, the three objectives were
investigated for West Europe10.

First, optimisation was performed for the order of peak new daily infections
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(PNDI). Each country was given a unique letter and a string produced to repre-
sent the order of peaks, for example: France=A, Spain=B, if Spain peaked first
the string was “BA”, else it was “AB”. The fitness function for Objective 1 was
achieved by encoding the required country order for peak time as a ten charac-
ter string, and minimising the Levenshtein distance between the target string and
the corresponding string representing the order of peaks obtained from the model.
Results are given in Table C.2. A smaller distance symbolises model predictions
to be closer to the observed data, and the RRHC algorithm searched for country
specific and inter-country infection parameters that reduced the distance measure
for this objective and the two below.

Secondly, optimisation was performed for the magnitude of PNDI by minimis-
ing the result of Equation 4. The measure produces a normalised value between
0 and 1, where 0 represented a perfect fit between target and modelled data, and
1 the worst possible fit, see Table C.3. Finally, for Objective 3, optimisation was
performed for both the order and magnitude of PNDI. The distance measure used
was a combination of the LD, and the measure in Objective 2, see Equation 5.
The distance measure produces a normalised value between 0 and 1, where 0 rep-
resented a perfect fit between modelled and predicted data, and 1 the worst fit.
Order and magnitude were given equal weight; see infection rates in Table C.4,
and travel rates in Table C.5.

distanceM =
| Target1−Model1
Max(Target1,Model1) |+ |

Target2−Model2
Max(Target2,Model2) |+ . . .+ | Targetn−Modeln

Max(Targetn,Modeln) |
n

(4)

distanceM+O =
distanceM + LD

n

2
(5)

Pseudo code for RRHCA:

Input: Randomly generated solution
Output: Best solution of all random starting solutions

1 for x = 1 to STARTS do:
2 S(R) = Randomly generated solution
3 F(R) = Fitness of S(R)
4 for i = 1 to ITERATIONS do:
5 S(C) = Small change to S(R)
6 F(C) = Fitness of S(C)
7 if F(C) better than F(R) then:
8 S(R) = S(C)
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9 end if
10 end for
11 return S(R)
12 end for

Levenshtein distance. The Levenshtein distance [Lev66] between two strings a,b
(of length | a | and | b | respectively) is given by leva,b(| a |, | b |), where

leva,b(i, j) =


max(i, j) If min(i, j)=0

min


leva,b = (i− 1, j) + 1

leva,b = (i, j − 1) + 1, otherwise
leva,b = (i− 1, j − 1) + 1(ai 6=bj)

where 1(ai 6=bj) is the indicator function equal to 0 when ai = bj and equal to 1 otherwise.
A normalised edit distance between two strings can be computed by

lev_norma,b =
leva,b

max(| a |, | b |)

3.3 Analytical methods
Linear Temporal Logic and Simulative Model checking. Model checking
permits us to determine if a model fulfils given properties specified in temporal log-
ics, e.g. probabilistic linear-time temporal logic PLTL [DG08]. Here we employ the
simulative model checker MC2 [DG08] over time series traces of behaviours generated
by simulation of epidemic and pandemic models. Our simulation platforms (Snoopy ,
Marcie, Spike) not only support the checking of time series behaviours of (uncoloured/-
coloured) places/compartments but also of (uncoloured/coloured) transitions/events,
for example Infect, Recover and Travel, or derived measures over both (observers). All
of these can be subsumed under the general term observables.

The basic element of any temporal logic is the Atomic Proposition (AP) which is
part of a property without temporal operators. The syntax of PLTL is:

φ ::= Xφ | Gφ | Fφ | φUφ | φRφ | φ ∨ φ | φ ∧ φ | ¬φ | φ→ φ | AP

AP ::= AP ∨AP | AP ∧AP | ¬AP | AP → AP |
z = z | z 6= z | z > z | z ≥ z | z < z | z ≤ z | true | false

z ::= z + z | z − z | z ∗ z | z/z | «x» | d(«x») | max(«x») | Int | Real
where «x» is the name of any observable in the simulation output, Int is any integer

number, Real is any real number, and d is the differential operator.
The temporal operators are:

• Next (X) - The property must hold true in the next time point.
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• Globally (G) - The property must hold true always in the future.

• Finally (F) - The property must hold true sometime in the future.

• Until (U) - The first property must hold true until the second property holds true.

• Release (R) - The second property can only ever not hold true if the first property
becomes true.

When checking small models with few variables, it is possible to check the properties
of specific observables, for example that of infectious in a simple SIR model. However,
when checking larger models with many observables, for example P48SIR-S10, we run
model checking for a set of observables against a library of PLTL properties, and employ
meta-variables indicated by double angle brackets in our queries, to be substituted one
by one by all observables in the set:

P≥1[G(«x» > 10) ]

which “Holds for any observable whose value is always greater than 10”, which in turn
could be generalised to a general pattern “x is always greater than some threshold”.

A library of appropriate property patterns, provided in the Supplementary Mate-
rial, allows us to categorise all model observables into (not necessarily disjunctive) sets
fulfilling the individual property patterns. Example patterns include
(1) Always zero. When applied to places, this indicates that a place has never been
initialised to a value greater than zero, and that it never participates in the progress
of the model. For transitions it indicates those which are never active, indicating that
they are part of the network that is always dead.

P≥1[G(«x» = 0 ) ], which is equivalent to P≥1[¬F («x» 6= 0 ) ]

(2) At some point greater than zero, and eventually zero. Places which have some
marking, and then hold a zero value at then end of the simulation; transitions with
changing activity and finally a steady state of zero activity.

P≥1[F (d(«x») 6= 0) ∧ F (G(«x» = 0 ∧ d(«x») = 0)) ]

(3) Activity peaks and falls:
P≥1[F (d(«x») > 0) ∧ (d(«x») > 0 U G(d(«x») < 0)) ]

(4) Activity peaks and falls then steady state:
P≥1[F (d(«x») > 0) ∧ (d(«x») > 0 U

(F (d(«x») < 0 ∧ G(d(«x») < 0 U G(d(«x»)) = 0))) ]

(5) At least one peak:
P≥1[F ((d(«x») > 0) ∧ F ((d(«x») < 0))) ]

(6) At least two peaks:
P≥1[F ((d(«x») > 0) ∧ F ((d«x») < 0) ∧ F ((d(«x») > 0) ∧ F ((d«x») < 0))))) ]

We have applied this to PChinaSIR, and discovered some provinces with multiple
peaks in Infectious when the infection was initiated in Hubei province (the capital of
which is Wuhan), due to their geographical placement, see Figure C.9.
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Cluster analysis is a method of creating groups where objects in one group are very
similar and distinct from other groups [GMW20]. In particular, agglomerative hierar-
chical cluster analysis was performed, which sequentially combines individual elements
into larger clusters until all elements are in the same cluster. Time-series cluster analy-
sis was performed on the Infectious compartment in non-fitted Europe10 (Figure C.13)
and non-fitted Europe48 (Figure C.14), where the infection was started in all locations.
The distance between time-series traces of Infectious compartments for each country
was computed using Euclidean distance and a distance matrix was constructed. Clus-
tering was performed using the complete link method, which takes the largest distance
between clusters to construct a dendrogram.

Bar charts. Exploratory data analysis involves using graphs and summary statistics
to explore data; this was exploited largely by plotting model outputs for visualisation
to ascertain whether or not the models were behaving as expected. The bar chart in
Figure C.5 was produced using simulation data exported as CSV files, and generated
in Excel.

Correlation matrices were computed to assess model behaviour in more depth
and was used to validate both unfitted and fitted models. Non-fitted models were
simulated several times with the infection starting in a different location, and then with
all locations infected. The magnitude and timing of peak infections were detected for
all simulations and combined into a single data frame. For the P10SIR fitted model,
the best result from the RRHCA optimisation was taken, and peak and timing of peaks
were detected. Data were loaded into R and real-world data on country population
density, country size, and the number of borders a country had were joined. Correlations
between variables were computed to determine the parameters that were closely linked
to higher numbers of infections. The correlation matrix was then plotted to visualise
and statistical significance determined at p < 0.05. Non-significant correlations were
displayed with a black cross. For details see Table C.6 and Figures C.10 –C.12.

3.4 Hardware and software requirements
Hardware. A standard computer with a Windows, Mac or Linux operating system
(preferably 64-bit). The minimum RAM required is 8GB; depending on the size of the
constructed model, more memory may be needed. More heavy simulation experiments
take advantage of multiple cores.

Software. The research reported in this paper has been achieved by help of the
PetriNuts platform, which is also required to reproduce the results. The platform
comprises several tools, which can be downloaded from http://www-dssz.informatik.tu-
cottbus.de/DSSZ/Software. All these tools can be installed separately, are free for
non-commercial use, and run on Windows, Linux, and Mac OS.
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• Snoopy [HHL+12] is Petri net editor and simulator supporting various types of
hierarchical (coloured) Petri nets, including all Petri net classes used in this pa-
per, with an automatic conversion between them. Snoopy supports several data
exchange formats, among them the Systems Biology Markup Language (SBML,
level 1 and 2). For communication within the PetriNuts platform, Snoopy reads
and writes ANDL (Abstract Net Description Language) and CANDL (Coloured
ANDL) files, and writes simulation traces (places, transitions, observers) as CSV
files. The ODEs induced by a CPN or CPN C can be exported to LaTeX, as
plain text, or be written to be read by Octave, Matlab, or ERODE [CTTV17].
Snoopy’s proprietary file format uses XML technology; default file extensions in-
dicate the net class (i.e., pn, spn, cpn, colpn, colspn, colcpn). A Snoopy2LATEX
generator supports documentation.

• Patty is a JavaScript to support Petri net animation (token flow) in a web browser;
it does not require any installation on the user’s site. Patty reads (uncoloured)
Petri nets in Snoopy’s proprietary format. All uncoloured Petri nets given in this
paper can be animated in a purely qualitative manner at https://www-dssz.
informatik.tu-cottbus.de/DSSZ/Research/ModellingEpidemics.

• Charlie [HSW15] is an analysis tool of (uncoloured) Petri net models applying
standard techniques of Petri net theory (including structural analysis, such as
conservativeness, and invariant analysis), complemented by explicit CTL and
LTL model checking. Charlie reads ANDL files, and writes some analysis results
(invariants, siphons, traps) into files, to be read by Snoopy for visualisation; for
details see [BHM15].

• Marcie [HRS13] is Model checker for qualitative Petri nets and SPN , and their
coloured counterparts; it combines exact analysis techniques gaining their effi-
ciency by symbolic data structures (IDD) [HRST16] with approximative analy-
sis techniques building on fast adaptive uniformization (FAU) and parallelized
stochastic simulation (Gillespie, tau leaping, delta leaping). It supports CTL,
CSL and PLTLc model checking. Marcie reads ANDL and CANDL files, and
writes stochastic simulation traces (places, transitions, observers) as CSV files.

• Spike [CH19] is a command line tool for reproducible stochastic, continuous and
hybrid simulation experiments of large-scale (coloured) Petri nets. Spike reads a
couple of file formats, among them are SBML, ANDL and CANDL, and writes
simulation traces (places, transitions, observers) as CSV files.

Snoopy , Marcie and Spike share a library of simulation algorithms, comprising
four stochastic simulation algorithms (besides Gillespie’s exact SSA, three approx-
imative algorithms) and a couple of stiff/unstiff solvers for continuous simulation
(some of them use the external library SUNDIAL CVODE [HBG+05]); see [CH19]
for a quick reference.
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• MC2 [DG08] is a Monte Carlo Model Checker for LTLc and PLTLc, operating
on stochastic, deterministic, and hybrid simulation traces or even wetlab data,
given as CSV files. We use MC2 to analyse deterministic and stochastic traces
generated by Snoopy or Spike.

Additionally, we recommend the use of several third-party tools for post-processing
of simulation traces.

• R - 3.6.2 and R Studio - Version 1.1.463, with packages dplyr 0.8.5, ggplot2 3.3.0,
openxlsx 4.1.4, corrplot 0.84, RColorBrewer 1.1-2, dtwclust 5.5.6, reshape2 1.4.3.

• Python - Version 3.6.5 and Visual Studio Code - 1.42.1, used for

– RRHCA (Random Restart Hill Climbing) using packages pandas 1.1.0, Lev-
enshtein 0.12.0, and packages pre-installed with Python: os, time, random,
datetime.

– Python Web Scraper, used to to collect COVID19 Data, using packages
urllib3 1.25.10, requests 2.24.0, lxml 4.5.2, bs4 0.0.1.

• Excel 16.40

4 Discussion
Model engineering is in general the science of designing, constructing and
analysing computational models. We have previously discussed this concept in the
context of biological models [HG13,BHM15], and the principles are equally applicable
to epidemic and pandemic models. Major objectives of this approach are the sound
reusability of models, and the reproducibility of their simulation and analysis results,
both being facilitated by the use of colour in Petri nets. In terms of the models presented
in this paper, we employ an approach based on orthogonal extensions of the basic SIR
model, enabling robust step-wise model development. Examples include the extension
of epidemic SIR models to pandemic models in a reusable manner, where models can
be scaled by modifying stratification colour sets, or adjusted to different geographies by
merely replacing the related colour definitions. More specifically, model engineering in
this context comprises three aspects: engineering model structure, spatial aspects, and
rates.

Engineering model structure. We exploit the concept of colour as supported in
coloured Petri nets, which facilitates parameterised repetition of model components, as
for example required to encode stratified populations. This enables modelling at a higher
level of abstraction akin to principles in high level programming languages. Abstraction
generally reduces design errors in large and complex models, but can introduce some
implementation errors due to misunderstanding of the coloured annotations.
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This calls for robust model validation before entering the simulation phase. With
increasing model size, this can hardly be accomplished by visual inspection only. Petri
nets offer structural analysis techniques for this purpose. For example, all the models
presented in this paper are by construction covered by P-invariants, and most models
are also conservative. Both properties can be easily checked using our Petri net analysis
tool Charlie (see Methods section for details). Besides this, animation of discrete Petri
nets offers the option to play with a net in order to follow the token flow, suggested as
an early check to reveal design faults.

Our use of colour enables us to construct multilevel models in a sound manner.
Specifically they encode two levels, the lower one being based on an SIR or its extensions,
and the upper level comprising a network of geographical connections, resulting in a
metapopulation model [Bra17]. The models are multiscale in terms of distances at the
upper level; regarding time, we assume that geographical connections, i.e. travel, occur
at much lower rates than infections in the lower level SIR components.

Engineering spatial aspects. The crucial difference between epidemic and pan-
demic models is the notion of space and connectivities permitting population movement
and hence the geographic transmission of disease. Our approach which is based on colour
and associated functions enables the encoding, for example, of set operators. This in
turn facilitates model design based directly on abstract representations of spatial re-
lationships as graphs. Modification of geographical relationships then merely involves
modifying the corresponding graph at the coloured high level, rather than attempting
to change the expanded and more complex unfolded low level. This all occurs within
one smooth coherent framework of coloured Petri nets, implemented seamlessly in our
PetriNuts platform.

Petri nets can be designed in a graphical or textual way, depending on personal
preferences. A combination of both is also possible; for example, designing the Petri
net structure graphically and writing all colour-related definitions using CANDL; see
Supplementary Material for details.

Engineering rates The increase in model size results in an increase both in the
number of kinetic parameters that need to be fitted, as well as an increase in the com-
plexity of their interdependencies. Our paper is a methodology paper, and parameter
fitting has been included as an illustration of what can be done with our approach.

In this paper we have discussed models where the rate constants are fixed for the
entirety of a simulation. Modelling lockdown situations, however, requires that rate
constants are changed dynamically during a simulation run. The imposition of lockdown
measures which are driven by social disease control policies effectively diminishes the
infection rate constant, and likewise lifting of the measures increases this value. These
changes are typically event driven, in response to changing Rt values for example.
We have recently extended the Spike simulator to include event-driven triggers, which
enables the modelling of these control measures, see for example Figure C.16. The
methodology enables the imposition of changes in an some incremental manner, in
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order to better represent the transitional nature of the uptake of lockdown measures in
practice. In more general terms modelling features such as the dynamic modification of
rate constants is a step towards self-adaptable models.
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Appendix

A PetriNuts Platform – Quick Reference
For newcomers to the PetriNuts platform we provide guidelines for some basic
use cases.

A.1 The Framework

time-free, qualitative

timed, quantitative

discrete state space
continuous state spaceQPN C

QPN

SPN C

SPN

CPN C

CPN

HPN C

HPN

• discrete states (N)
• no rates
• LTS, PO
• animation
• CTL/LTL

• discrete states (N)
• stochastic rates
• CTMC
• animation,
stochastic simulation

• CSRL/PLTLc

• continuous states (R+)
• deterministic rates
• ODEs
• deterministic simulation
• LTLc

folding
unfolding

abstraction
extension

approximation

• discrete & continuous states (N ∪ R+)
• stochastic & deterministic rates
• CTMC coupled by Markov jumps
• hybrid simulation
• PLTLc

Figure A.1: Paradigms of the unifying framework. Paradigms integrated in
the unifying framework of the PetriNuts platform (adapted from [HHL+12]). The
arrows describe the relations supported by automatic file transformation (export,
unfolding); except folding, which in most cases has to be done manually.

Net classes given in Figure A.1:

• QPN , QPN C- (coloured) qualitative Petri nets (standard Petri nets)
• SPN , SPN C- (coloured) stochastic Petri nets
• CPN , CPN C- (coloured) continuous Petri nets
• HPN , HPN C- (coloured) hybrid Petri nets

Remark: There are also fuzzy extensions of all six quantitative Petri nets [AHL19].

Annotation index for Figure A.1:

• interpretation of marking
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• reaction rates
• semantics
• execution type: animation/simulation type
• temporal logic type corresponding to the given semantics to describe expected
properties

A.2 How to use Snoopy

Snoopy [HHL+12] is written in C++, using the Standard Template Library and
the cross-platform toolkit wxWidgets [WxW21]. The installation files, together
with many other resources, are available at https://www-dssz.informatik.
tu-cottbus.de/DSSZ/Software/Snoopy. Snoopy comes with a graphical user
interface; thus all the following use cases start with Open Snoopy.

(1) How to obtain the graphical representation for a CANDL file:
• File→ Import x.candl
• Edit→ Layout→ chose layout algorithm
• V iew → Show attributes → for all net elements, select the attributes you
want to see

• File→ Save x (as colspn or colcpn)

(2) How to obtain the unfolded net:
• File→ Open x (colspn or colcpn)
• File→ Export as andl file using dssd_util // involves unfolding
• File→ Import x.andl → select new model
• Edit→ Layout→ chose layout algorithm
• File→ Save x (as spn or cpn)

Remarks:
• export of colspn (colcpn) to spn (cpn) also involves unfolding;
• alternatively, unfolding can be done via the command line tool Spike:
spike load -f=x.candl unfold save -f=x.andl

(3) How to convert SPN ⇔ CPN or SPN C ⇔ CPN C:
• File→ Open x.spn
• File→ Export as x.cpn
• File→ Open x.cpn

Remarks: or vice versa; likewise for SPN C, CPN C;
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(4) How to obtain (C)ANDL files:

• File→ Open x (spn/cpn)
• File→ Export to ANDL
or

• File→ Open x (colspn/colcpn)
• File→ Export to CANDL

(5) How to obtain the ODEs of a given CPN/CPN C:

• File→ Open x (cpn/colcpn)
• File→ Export→ ODEs to LaTeX or Text, Octave, Matlab

Remarks:

• ODEs can also be exported as plain text by the simulation window’s export
options;

• CPN C have to be unfolded to CPN , before generating the ODEs;

(6) How to reuse colour definitions:

• construct your (epidemic) model as SPN C/CPN C;
alternatively, if you already have an uncoloured version x, do

– File→ Open x
– File→ export to corresponding coloured net class; i.e.,
SPN can be exported to SPN C, and CPN to CPN C.

– File→ Open the coloured version of x

• File→ Import y.candl // the file providing the required colour definitions

– chose Selective import
– chose Select all or individually select the subset of required definitions
– press OK

• check if the colour definitions were imported as expected;

Remark: Advanced users may alternatively edit CANDL files with their
favourite text editor.
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(7) How to simulate with Snoopy :

• File→ Open x (spn/colspn/cpn/colcpn)
• V iew → Start Simulation Mode
• chose Model Configuration
• chose Simulator Configuration
• open some Views by double click
• click Start Simulation

Remark: For more details see Snoopy’s Manuals [LHR12,HLRH17] and related
textbook chapters [MRH12,BHM15].

A.3 How to use Patty

Patty is a JavaScript to support Petri net animation (token flow) in a web browser;
it does not require any installation on the user’s site. Patty reads (uncoloured)
Petri nets in Snoopy’s proprietary format.

All uncoloured Petri nets given in this paper can be animated in a purely
qualitative manner at https://www-dssz.informatik.tu-cottbus.de/DSSZ/
Research/ModellingEpidemics.

• A click on the picture opens a new window with a Petri net, directly exe-
cutable in your web brower by help of Patty; nothing needs to be installed.

• Then, the PN can be animated by either clicking on individual transitions
(boxes) or one of the smallish triangles in the control panel.

• Clicking on a place adds a token.

A.4 How to use Charlie

Charlie [HSW15] is written in Java; thus it requires a Java runtime environ-
ment. The jar file is available at https://www-dssz.informatik.tu-cottbus.
de/DSSZ/Software/Charlie. Charlie comes with a graphical user interface; thus
all the following use cases start with Open Charlie.

• file→ open x (andl)
• net properties – summary vector of the results achieved so far; acronyms
are explained by a tool tip feature.

• IM-based analysis – computation of P-/T-invariants, which can be writ-
ten to a text file (see options) and are read by Snoopy → Extras →
Load node set file.
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• siphon/trap computation – among others, bad siphons can be identified
and written to a text file (click export siphons) and are read by Snoopy
→ Extras→ Load node set file.

• protocol – a more verbose summary of the analysis results achieved so far.
• file → exit – all analysis results can be found in a log file, written to the
folder from where the ANDL file had been loaded.

Remark: For more details see [Fra09,HSW15] and Charlie’s webpage.

A.5 How to use Spike

Spike [CH19] is a command line tool written in C++, available at https://
www-dssz.informatik.tu-cottbus.de/DSSZ/Software/Spike. Thus all com-
mands have to be entered in a terminal.

(1) How to unfold: Enter
spike load -f=x.candl unfold save -f=x.andl

(2) How to simulate: For reproducible simulation experiments, Spike builds
on a configuration file (to be written in its own configuration language), where
all details of how to configure the model and the simulator(s) to be used need to
be specified. Assuming the configuration file has the name config.spc, enter

spike exe -f=config.spc

Remarks:

• We provide configuration files to simulated P10SIR with optimised kinetic
rate constants and to produce Figure C.16 illustrating dynamic rate con-
stants.

• For more details see [CH19] and Spike’s webpage.

A.6 How to use MC2
MC2 [DG08] is written in Java; thus it requires a Java runtime environment. The
jar file is available at https://www-dssz.informatik.tu-cottbus.de/DSSZ/
Software/MC2. MC2 is a command line tool and performs offline simulative
model checking of Probabilistic Linear-time Temporal Logic (PLTL). It requires
as input a file of time series traces in CSV format, and a file of the PLTL proper-
ties to be checked. The property file contains one property per line, in the form
P≥1[G([x] = 0 ) ] where x is an entity named (coloured/uncoloured place/transi-
tion/observer) in the traces file. The call is:
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java -jar MC2v2.0beta2.jar det TracesFile PropertiesFile
and the output comprises, for each property checked, the property formula and
on the next line the result (true or false).

We have compiled a library of useful properties which can be used directly or
adapted as required. These library properties employ meta variables indicated by
$x in the properties, to be substituted one by one by all observables in the input
time series csv file of behaviour traces, e.g.

P>=1 [ G([$x]>=0) ]
We have developed a Unix script to automatically expand these meta variables

to the observables in a given csv file so that there is a version of the properties
for each observable, and then to run the model checker on the csv file and the
expanded property file. The property library and Unix script are provided.
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B Exchange formats

B.1 ANDL – Abstract Net Description Language

ANDL has been designed as a concise, but human-readable exchange format for
(uncoloured) Petri nets, written as plain ASCII text. For illustration of the ANDL
syntax, we give a couple of examples; for formal definitions see [SRH16].

The very first keyword (spn/cpn) determines the net class – SPN or CPN .
An ANDL specification consists basically of three lists: the constants, the places
and the transitions. Constants can hold several value sets and can be organised in
groups (here: marking and parameter, which are pre-defined groups, extended by
the user-defined groups par_ratio, standard-incidence). Models can be configured
by choosing for each constant group a specific value set. For example, to apply
the standard incidence, choose the Main value set (N will be set to I0 + S0), to
apply Mass-action kinetics, choose V_Set_0 (N will be set to 1).

Example 1: SIR.spn - Figure 1 in ANDL notation.

spn [SIR]
{
constants:

valuesets[Main:V_Set_0:V_Set_1:V_Set_2:V_Set_3:V_Set_4:V_Set_5:V_Set_6]
marking:

int S0 = [100:1e3:1e4:1e5:1e6:1e7:1e8:];
int I0 = [1:S0/100::::::];

standardIncidence:
int N = [I0+S0:1::::::];

par_ratio:
double ratio = [1:0.1:0.01:1.0e-3:2:3:4:5];

parameter:
double k_infect = [1:0.1:0.01:1.0e-3:1.0e-4:1.0e-5:1.0e-6:];
double k_recover = [k_infect*ratio:::::::];

places:
Susceptible = S0;
Infectious = I0;
Recovered = 0;

transitions:
Infect

:
: [Infectious + 2] & [Susceptible - 1] & [Infectious - 1]
: MassAction(k_infect/N)
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;
Recover

:
: [Recovered + 1] & [Infectious - 1]
: MassAction(k_recover)
;

}

Example 2: SIR.cpn - Figure 1 in ANDL notation. In terms of ANDL
syntax, the only difference between SPN and CPN (besides the very first key-
word) is the keyword continuous (occurring after places and transitions) which
reminds us that places and transitions of a CPN are treated as continuous nodes.

cpn [SIR]
{
constants:

valuesets[Main:V_Set_0:V_Set_1:V_Set_2:V_Set_3:V_Set_4:V_Set_5:V_Set_6]
marking:

int S0 = [100:1e3:1e4:1e5:1e6:1e7:1e8:];
int I0 = [1:S0/100::::::];

standardIncidence:
int N = [I0+S0:1::::::];

par_ratio:
double ratio = [1:0.1:0.01:1.0e-3:2:3:4:5];

parameter:
double k_infect = [1:0.1:0.01:1.0e-3:1.0e-4:1.0e-5:1.0e-6:];
double k_recover = [k_infect*ratio:::::::];

places:
continuous:

Susceptible = S0;
Infectious = I0;
Recovered = 0;

transitions:
continuous:

Infect
:
: [Infectious + 2] & [Susceptible - 1] & [Infectious - 1]
: MassAction(k_infect/N)
;

Recover
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:
: [Recovered + 1] & [Infectious - 1]
: MassAction(k_recover)
;

}

Example 3: SIR-S2.spn - Figure 3 (Top) in ANDL notation.

spn [SIR-S2]
{
constants:

valuesets[Main:V_Set_0:V_Set_1:V_Set_2:V_Set_3:V_Set_4:V_Set_5:V_Set_6]
marking:

int SY0 = [50000:::::::];
int SO0 = [50000:::::::];
int IY0 = [1:::::::];
int IO0 = [0:::::::];

standardIncidence:
int N = [SY0+SO0+IY0+IO0:1::::::];

par_ratio:
double ratio = [1:0.1:0.01:1.0e-3:2:3:4:5];

parameter:
double k_infect = [1:0.1:0.01:1.0e-3:1.0e-4:1.0e-5:1.0e-6:];
double k_recover = [k_infect*ratio:::::::];
double k_crossInfect = [k_infect/0.1:::::::];

places:
Susceptible_Young = SY0;
Susceptible_Old = SO0;
Infectious_Young = IY0;
Infectious_Old = IO0;
Recovered_Young = 0;
Recovered_Old = 0;

transitions:
InfectYoung

:
: [Infectious_Young + 2] & [Susceptible_Young - 1] & [Infectious_Young - 1]
: MassAction(k_infect/N)
;

RecoverYoung
:
: [Recovered_Young + 1] & [Infectious_Young - 1]
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: MassAction(k_recover)
;

RecoverOld
:
: [Recovered_Old + 1] & [Infectious_Old - 1]
: MassAction(k_recover)
;

InfectOld
:
: [Infectious_Old + 2] & [Infectious_Old - 1] & [Susceptible_Old - 1]
: MassAction(k_infect/N)
;

OldInfectYoung
:
: [Infectious_Young + 1] & [Infectious_Old + 1] &

[Susceptible_Young - 1] & [Infectious_Old - 1]
: MassAction(k_crossInfect/N)
;

YoungInfectOld
:
: [Infectious_Young + 1] & [Infectious_Old + 1] &

[Susceptible_Old - 1] & [Infectious_Young - 1]
: MassAction(k_crossInfect/N)
;

}

B.2 CANDL – Coloured ANDL

CANDL is an extension of ANDL; it has been designed as a concise, but human-
readable exchange format for coloured Petri nets, written as plain ASCII text. For
illustration of the CANDL syntax, we give two examples; for formal definitions
see [ACR+21].

Example 4 shows the coloured version of Example 3, i.e., unfolding the
CANDL code in Example 4 gives the ANDL code in Example 3. The nam-
ing convention for unfolded places is exactly as shown here (name of the coloured
place followed by one of its colours, separated by an underscore), the naming of
unfolded transitions slightly differs.

The rates of the transition Infect are colour-dependent; the appropriate
colours are determined by a Boolean expression, forming a guard, which in turn
is given in square brackets.
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Example 4 - SIR-S_enum.colspn - Figure 3 (Middle) in CANDL nota-
tion.

colspn [SIR-S2_enum]
{
constants:

valuesets[Main:V_Set_0:V_Set_1:V_Set_2:V_Set_3:V_Set_4:V_Set_5:V_Set_6]
marking:

int SY0 = [50000:::::::];
int SO0 = [50000:::::::];
int IY0 = [1:::::::];
int IO0 = [0:::::::];

standardIncidence:
int N = [SY0+SO0+IY0+IO0:1::::::];

par_ratio:
double ratio = [1:0.1:0.01:1.0e-3:2:3:4:5];

parameter:
double k_infect = [1:0.1:0.01:1.0e-3:1.0e-4:1.0e-5:1.0e-6:];
double k_crossInfect = [k_infect/0.1:::::::];
double k_recover = [k_infect*ratio:::::::];

colorsets:
Dot = {dot};
enum Strata = {Young,Old};

variables:
Strata : x;
Strata : y;

places:
discrete:

Strata Infectious = IY0‘Young++IO0‘Old;
Strata Recovered = 0‘Young++0‘Old;
Strata Susceptible = SY0‘Young++SO0‘Old;

transitions:
Infect

:
: [Infectious + {x++y}] & [Susceptible - {x}] & [Infectious - {y}]
: [(x=Young&y=Young)|(x=Old&y=Old)] MassAction(k_infect/N) ++

[(x=Young&y=Old)|(x=Old&y=Young)] MassAction(k_crossInfect/N)
;

Recover
:
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: [Recovered + {x}] & [Infectious - {x}]
: MassAction(k_recover)
;

}

Example 5 is structurally equivalent to Example 4, but uses a different colour
set to encode stratification. Example 4 defines an enumeration set, which can be
extended by adding further keywords. In contrast, Example 5 defines an integer
subset, ranging from 1 to an upper bound given by the constant StrataNum, which
simplifies scaling to an arbitrary number of strata. In terms of implementation,
there isn’t much of a difference as enumeration types are internally mapped to
integer types. Thus the keywords of an enumeration type (here: Young, Old) are
merely syntactic sugar, which may improve readability. For further details of the
supported colour sets and related colouring principles, see [LHR12].

Example 5 - SIR-S_int.colspn - Figure 3 (Middle) in CANDL notation.

colspn [SIR-S2_int]
{
constants:

valuesets[Main:V_Set_0:V_Set_1:V_Set_2:V_Set_3:V_Set_4:V_Set_5:V_Set_6]
coloring:

int StrataNum = [2:::::::];
marking:

int SY0 = [50000:::::::];
int SO0 = [50000:::::::];
int IY0 = [1:::::::];
int IO0 = [0:::::::];

standardIncidence:
int N = [SY0+SO0+IY0+IO0:1::::::];

par_ratio:
double ratio = [1:0.1:0.01:1.0e-3:2:3:4:5];

parameter:
double k_infect = [1:0.1:0.01:1.0e-3:1.0e-4:1.0e-5:1.0e-6:];
double k_crossInfect = [k_infect/0.1:::::::];
double k_recover = [k_infect*ratio:::::::];

colorsets:
Dot = {dot};
Strata = {1..StrataNum};

variables:
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Strata : x;
Strata : y;

places:
discrete:

Strata Infectious = IY0‘1++IO0‘2;
Strata Recovered = 0‘1++0‘2;
Strata Susceptible = SY0‘1++SO0‘2;

transitions:
Infect

:
: [Infectious + {x++y}] & [Susceptible - {x}] & [Infectious - {y}]
: [(x=1&y=1)|(x=2&y=2)] MassAction(k_infect/N) ++

[(x=1&y=2)|(x=2&y=1)] MassAction(k_crossInfect/N)
;

Recover
:
: [Recovered + {x}] & [Infectious - {x}]
: MassAction(k_recover)
;

}

B.3 ODEs generated

For illustration we provide here for selected CPN /CPN C the ODEs which are
automatically generated when it comes to simulating a model; for CPN C this
involves unfolding. To feed the ODEs to another simulator tool, consider the
option to export to Matlab, Octave, or ERODE [CTTV17]; otherwise you may
start from the plain text representation to obtain your required representation
style; all of these exports are supported by Snoopy .
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(1) ODEs - SIQR - Figure 2 (Top).

dSusceptible
dt

= −(k_infect/N ∗ Susceptible ∗ Infectious)

dRecovered
dt

= +(k_recover ∗ Infectious) + (k_recover ∗Quarantine)

dInfectious
dt

= +(k_infect ∗ Susceptible ∗ Infectious)
−(k_recover ∗ Infectious)− (k_quar ∗ Infectious)

dQuarantine
dt

= +(k_quar ∗ Infectious)− (k_recover ∗Quarantine)

(2) ODEs - SIAR - Figure 2 (Bottom).

dInfectiousSymptomatic
dt

= +(k_infect/N ∗ Susceptible ∗ InfectiousSymptomatic)
+(k_infect/N ∗ Susceptible ∗ InfectiousAsymptomatic)
+(k_symptoms ∗ InfectiousAsymptomatic)
−(k_recover ∗ InfectiousSymptomatic)

dRecoveredSymptomatic
dt

= (k_recover ∗ InfectiousSymptomatic)

dSusceptible
dt

= −2(k_infect/N ∗ Susceptible ∗ InfectiousSymptomatic)
+(k_infect/N ∗ Susceptible ∗ InfectiousAsymptomatic)

dInfectiousAsymptomatic
dt

= +(k_infect/N ∗ Susceptible ∗ InfectiousSymptomatic)
+(k_infect/N ∗ Susceptible ∗ InfectiousAsymptomatic)
−(k_symptoms ∗ InfectiousAsymptomatic)
−(k_recover ∗ InfectiousAsymptomatic)

dRecoveredAsymptomatic
dt

= (k_recover ∗ InfectiousAsymptomatic)
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(3) ODEs - SIR-S2 - Figure 3.
dInfectiousYoung

dt
= +(k_crossInfect/N ∗ Susceptible_Young ∗ Infectious_Old)

+(k_infect/N ∗ Susceptible_Young ∗ Infectious_Young)
−(k_recover ∗ Infectious_Young)

dRecoveredYoung

dt
= +(k_recover ∗ Infectious_Young)

dSusceptibleYoung

dt
= −(k_infect/N ∗ Susceptible_Young ∗ Infectious_Young)
−(k_crossInfect/N ∗ Susceptible_Young ∗ Infectious_Old)

dSusceptibleOld

dt
= −(k_infect/N ∗ Infectious_Old ∗ Susceptible_Old)
−(k_crossInfect/N ∗ Susceptible_Old ∗ Infectious_Young)

dRecoveredOld

dt
= (k_recover ∗ Infectious_Old)

dInfectiousOld

dt
= +(k_crossInfect/N ∗ Susceptible_Old ∗ Infectious_Young)

+(k_infect/N ∗ Infectious_Old ∗ Susceptible_Old)
−(k_recover ∗ Infectious_Old)

(4) ODEs - P2SIR - Figure 4.
dSDE

dt
= −(k_infect/N ∗ I_DE ∗ S_DE) + (k_travel ∗ S_FR)− (k_travel ∗ S_DE)

dRDE

dt
= +(k_recover ∗ I_DE) + (k_travel ∗ R_FR)− (k_travel ∗ R_DE)

dIDE

dt
= +(k_infect/N ∗ I_DE ∗ S_DE)

+(k_travel ∗ I_FR)
−(k_recover ∗ I_DE)
−(k_travel ∗ I_DE)

dSFR

dt
= −(k_infect/N ∗ I_FR ∗ S_FR) + (k_travel ∗ S_DE)− (k_travel ∗ S_FR)

dRFR

dt
= +(k_recover ∗ I_FR) + (k_travel ∗ R_DE)− (k_travel ∗ R_FR)

dIFR

dt
= +(k_infect/N ∗ I_FR ∗ S_FR)

+(k_travel ∗ I_DE)
−(k_recover ∗ I_FR)
−(k_travel ∗ I_FR)
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C Additional Figures and Tables
The following subsection titles correspond to the ones in the main paper.

C.1 Extended epidemic models

Figure C.1 shows SIVR – an SIR model extended by a virus variant represented
as HPN , and a hybrid simulation trace.

C.2 Pandemic models

P4SIR model, unfolded is given in Figure C.2.
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Mutant

Infectious
1

Recovered

Susceptible

30

InfectiousVariant RecoveredVariant

Infect

Recover

RecoverVariant

InfectVariant

Mutation
<1>

2

2

Figure C.1: SIVR model. (Top) HPN describing the introduction of a virus
variant, using a deterministic transition Mutation which fires with a delay of 1
time unit after simulation start. Kinetic parameters: ratio between Infect and
Recover, RecoverVariant is 1:10; ratio between Infect and InfectVariant is 1:5.
(Bottom) Hybrid simulation trace for Infectious and InfectiousVariant.
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Infectious_BE

Infectious_DE
10

Infectious_ES

Infectious_FR

Recovered_BE

Recovered_DE
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Susceptible_BE
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2
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2
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Figure C.2: P4SIR model, unfolded obtained by unfolding P4SIR, shown in
Figure 5 (Middle), layout automatically generated.
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C.3 Combined models

P10SIQR model in two versions – see Figure C.3.

arrival may possibly involve quarantineold name:
SC_Model7_Europe1SIR_SCpolicy2.candl
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Figure C.3: P10QSIR model in two versions for West Europe (10 countries).
(Top) P10QISIR. Arrival by Infectious may possibly involve quarantine. There is
an additional place CumulativeInfectious to keep a record of total infections over
time. Note: this additional place destroys the conservativeness and induces a
second P-invariant, comprising (all uncoloured places of) Susceptible and Cumu-
lativeInfectious. A related analysis is given in Figure C.5. (Bottom) P10QSIR.
All arrivals will involve quarantine.
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C.4 Parameter fitting

Parameter scanning. Examples for varying rate parameters, see Figure C.4
for SIQR, and Figure C.5 for P10QISIR.

Figure C.4: SIQR model with variable quarantine rates. Four simulations
of model SIQR (Figure 2 (Top)) with different Quarantine rates. NoQ = 0, LowQ
= 10x less than Recover, RecQ = Recover, HighQ = 10x greater than Recover.
(Top) Infectious compartment, (Bottom) Quarantined compartment.
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Figure C.5: P10QISIR model – effect of modifying quarantine rates. Ac-
tive and CumulativeInfectious for Germany with varying rates of Quarantine.
Output from model in Figure C.3 (Top). X axis: rates for how many people go
into quarantine. Y axis: Data for the peaks (active infectious at peak, cumulative
at peak). Interpretation: up to a certain point quarantine only suppresses the
active cases but not cumulative, lengthening out the curve, until quarantine is
high.
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Parameter optimisation. The model fitted was P10SIR in the un-
folded version (see Figure C.6, and supplementary files P10SIR.candl,
P10SIR_Separate_Rates.andl and P10SIR_Separate_Rates.cpn) employing a
Random Restart Hill Climbing Algorithm (RRHCA) using real world data given
in Table C.1, with results for Infection rates given in Table C.2 (Objective 1),
Table C.3 (Objective 2), and Table C.4 (Objective 3). The Connection rates for
Objective 3 are given in Table C.5.
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I_m0CH Infectious_DE

I_m0DE

Infectious_DK
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I_m0FR

Infectious_IT
I_m0IT

Infectious_NL
I_m0NL
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CumulativeInfectious_AT

CumulativeInfectious_BECumulativeInfectious_CH

CumulativeInfectious_DE

CumulativeInfectious_DK

CumulativeInfectious_ES

CumulativeInfectious_FR

CumulativeInfectious_IT

CumulativeInfectious_NL

CumulativeInfectious_PT

Susceptible_AT
V_m0AT

Susceptible_BE
V_m0BE

Susceptible_CH
V_m0CH Susceptible_DE

V_m0DE
Susceptible_DK
V_m0DK

Susceptible_ES
V_m0ES

Susceptible_FR
V_m0FR

Susceptible_IT V_m0IT
Susceptible_NL
V_m0NL

Susceptible_PT

V_m0PT

2

2

2

2

2

2

2

2

2

2

Figure C.6: P10SIR model. CPN for SIR, West Europe, with a CumulativeIn-
fectious place to keep a record of total infections over time; obtained by unfolding
and automatic layout.
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Figure C.7: Data used to fit P10SIR . Real world data: daily new
cases for 10 Western Europe countries, source data from WorldOmeters
(https://www.worldometers.info/coronavirus/) for 19th January to 16th August
2020. Data smoothed by using a 7-day rolling average. Time: day 0 is after 5
or more cumulative deaths. Peak is the raw number. The figure shows clearer
peaks for countries which reported a higher number of cases. Data used to fit the
model given in Figure C.6.
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Table C.1: Real world data: peak magnitude and timing of daily new
cases for 10 Western Europe countries, source data from WorldOmeters
(https://www.worldometers.info/coronavirus/) for 19th January to 16th August
2020.

Country Time Peak
Austria 8 754
Switzerland 11 1112
Portugal 13 803
Spain 14 8987
Denmark 19 328
Germany 19 5837
France 26 4537
Belgium 29 1453
Italy 30 5646
Netherlands 33 1120

Table C.2: Objective 1: Summary statistics for Random Restarts achieving the
best Levenshtein Distance of 2 for model given in Figure C.6. RR = Random
Restart and n refers to the number of solutions producing the summary statistics.

Infection Rates RR0 (n=202) Infection Rates RR5 (n=186) Infection Rates RR9 (n=315)
Country Mean Min Max Mean Min Max Mean Min Max
Austria 8.34e−8 3.24e−8 1.69e−7 4.05e−8 2.33e−8 6.72e−8 5.92e−7 1.69e−7 1.03e−6

Belgium 2.82e−6 2.07e−6 4.72e−6 1.98e−6 1.24e−6 3.41e−6 5.40e−7 6.68e−8 1.06e−6

Switzerland 6.72e−6 4.09e−6 1.20e−5 5.16e−7 2.64e−7 1.10e−6 1.41e−7 3.86e−9 6.89e−7

Germany 5.55e−7 3.92e−7 7.41e−7 1.98e−5 5.38e−6 3.59e−5 1.61e−6 4.88e−7 4.58e−6

Denmark 6.19e−7 1.45e−7 1.54e−6 2.93e−6 4.90e−7 9.79e−6 1.05e−7 3.51e−8 2.46e−7

Spain 2.53e−6 9.18e−7 1.00e−5 1.49e−6 8.47e−7 2.52e−6 3.83e−6 1.01e−6 9.52e−6

France 6.11e−7 4.80e−7 8.72e−7 4.83e−7 2.46e−7 7.26e−7 7.47e−7 3.44e−7 1.49e−6

Italy 4.72e−7 2.98e−7 7.00e−7 2.99e−7 2.23e−7 6.02e−7 3.45e−7 1.83e−7 5.68e−7

Netherlands 5.71e−7 3.11e−7 1.28e−6 8.31e−7 6.16e−7 1.40e−6 7.81e−7 6.10e−7 1.14e−6

Portugal 1.51e−7 5.13e−8 4.50e−7 3.35e−5 5.24e−6 8.36e−5 8.82e−5 2.63e−5 2.21e−4
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Table C.3: Objective 2: Infection rates output from the best solution from the
RRHCA for model given in Figure C.6. (left) Sorted alphabetically, (right) sorted
by rate.

Country Infection Rate
Austria 3.64e−5
Belgium 4.31e−5
Switzerland 3.46e−6
Germany 3.48e−6
Denmark 6.94e−6
Spain 1.80e−5
France 4.44e−6
Italy 6.57e−6
Netherlands 2.36e−6
Portugal 3.22e−5

Country Infection Rate
Netherlands 2.36e−6
Switzerland 3.46e−6
Germany 3.48e−6
France 4.44e−6
Italy 6.57e−6
Denmark 6.94e−6
Spain 1.80e−5
Portugal 3.22e−5
Austria 3.64e−5
Belgium 4.31e−5

Table C.4: Objective 3: Infection rates output from the best solution from the
RRHCA for model given in Figure C.6.(left) Sorted alphabetically, (right) sorted
by rate.

Country Infection Rate
Austria 4.05e−5
Belgium 8.03e−6
Switzerland 3.49e−5
Germany 2.89e−6
Denmark 8.69e−6
Spain 7.58e−6
France 3.75e−6
Italy 6.20e−6
Netherlands 1.11e−6
Portugal 3.49e−5

Country Infection Rate
Netherlands 1.11e−6
Germany 2.89e−6
France 3.75e−6
Italy 6.20e−6
Spain 7.58e−6
Belgium 8.03e−6
Denmark 8.69e−6
Portugal 3.49e−5
Switzerland 3.49e−5
Austria 4.05e−5
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Table C.5: Objective 3: Travel rates output from the best solution from the
RRHCA for model given in Figure C.6 (Infection rates in Table C.4). Columns:
Connection from; Rows: Connection to.

AT BE CH DE DK ES FR IT NL PT
AT 3.553e−6 1.471e−6 1.086e−5

BE 1.115e−6 5.525e−6 5.408e−7

CH 3.786e−6 1.56e−6 3.389e−7 6.361e−6

DE 3.390e−6 7.833e−6 3.443e−6 2.125e−6 4.267e−6 3.187e−6

DK 1.960e−6

ES 1.462e−6 1.565e−6

FR 1.291e−6 1.425e−6 1.082e−5 2.630e−6 7.151e−6

IT 2.535e−6 2.529e−6 1.75e−6

NL 9.549e−6 2.342e−6

PT 2.071e−5
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C.5 Analysis

Visual analysis. For an example see Figure C.8.

Figure C.8: P10SIR behaviour. Modelled infections for 10 Western European
countries connected by road. AT = Austria, BE = Belgium, CH = Switzerland,
DE = Germany, DK = Denmark, ES = Spain, FR = France, IT = Italy, NL =
Netherlands and PT = Portugal. Plots for countries under 100 Infected are not
visible due to the scale of the graph.
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Model checking For illustration we include one experiment involving model
checking, see Figure C.9.
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Figure C.9: PChinaSIR model checking. (Top, left) Time series traces of In-
fectious for the 34 provinces, with infection starting in Hubei. The ratio between
rate constants for Infect and Recover is 1 : 104 (kinfect = 1.0e−6, krecover = 1.0e−2.)
(Top, right) Model checking reveals three provinces with more than one peak.
(Bottom) Network of China highlighted to indicate the geographical context of
the three provinces: HB - red, NX - green, QH - brown, XZ - blue.
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Correlation analysis. Table C.6 records the variables, correlation matrices
are given in Figure C.10, C.11, C.12. The correlation matrices for the unfitted
models indicate that the percent of population infected at peak is related to
the population size for P48SIR, but not for the smaller model P10SIR, perhaps
because there are more smaller countries in the smaller model. The number of
connections is related to the peak and peak pecentage in the larger model, but
only to the peak in the smaller model. Area is a partial proxy for the whole
population and is strongly related to peak and time (negatively - i.e. earlier) but
not to peak percentage in P10SIR. However in P48SIR area is related to peak and
peak percentage but not to time.

However, the correlation over the fitted data indicates that the percentage
of the population at the peak is less related to the population size, compared
with the unfitted model. Also the size of the peak was less related to length of
time from the start of infections in the fitted model compared to the unfitted
model. Finally, the time of the peak of infections was not correlated with the
number of inter-country connections in the fitted model, as opposed to being
negatively correlated in the unfitted model (more connections implying earlier
peaks), indicating that the intervention policies that governments have taken to
control the epidemic in their countries have overriden the effect of geographical
connections (i.e. closing down inter-country travel).

Table C.6: Variables used to investigate road connected models further. Cat-
egories: (1) real world data external to model, (2) derived measure connecting
external (black) to blue, (3) real world data incorporated in model, (4) data
generated by model.

Category Variable Description
1 Area.Km2 Area in km2 of a given country.
2 Density Population density of a given country (population/km2).
3 Connections Number of connections a country has in land borders.

initSusc Susceptible + Infected at time 0.
Population The real-world country populations.
MapPop The population used in the model (real world population / 1000).

4 peak The peak of Infected, this represents active cases.
peakPerc The percentage of initSusc that were infected at the peak.
time The number of steps into the simulation the peak occurred.
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Figure C.10: Correlation matrix for P10SIR, not fitted. Green indicates a
strong positive correlation and red indicates a strong negative correlation. Black
crosses represent a non-significant correlation. Infection rates and travel rates all
identical at 1.0e−6; recovery rates 1.0e−2.
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Figure C.11: Correlation matrix for P10SIR, fitted. Green indicates a strong
positive correlation and red indicates a strong negative correlation. Black crosses
represent a non-significant correlation.

30 March 2021 73



From Epidemic to Pandemic Modelling

Figure C.12: Correlation matrix for P48SIR, not fitted. Green indicates a
strong positive correlation and red indicates a strong negative correlation. Black
crosses represent a non-significant correlation.
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Dendrograms. Examples are given in Figures C.13, C.14.

Figure C.13: Dendrogram of P10SIR for West Europe, hierarchical clustering.
Height is on the x-axis. Data not normalised

Figure C.14: Dendrogram of P48SIR for Europe, hierarchical clustering.
Height is on the x-axis. Data not normalised.
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C.6 Discussion.

Results of simulating lockdown and unlock by dynamic change of infection rates
in the SIR model; Figure C.15 - lockdown only, Figure C.16 - lockdown followed
by unlock.

Figure C.15: SIR model - Dynamic change of infection rates: lockdown.
Output from the SIR model in Figure 1 where infection rates were stepwise decre-
mented during simulation. Figure legend shows cumulative infections for different
number of decrements.
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Figure C.16: SIR model, dynamic change of infection rate increased back
to pre-intervention level at time step 20.
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D List of Files Provided
All models given in figures (provided as Snoopy files):

• SIR.spn - standard SIR, see Figure 1
• SIQR.spn - SIR extended by quarantine, see Figure 2 (Top)
• SIAR.spn - SIR extend by symptomatic/asymptomatic compartments, see
Figure 2 (Bottom)

• SIR-S2.spn - SIR-Sage
2 , uncoloured, see Figure 3 (Top)

• SIR-S2_enum.colspn, SIR-S2_int.colspn - SIR-Sage
2 , coloured, see

Figure 3 (Middle)
• SIR-S20.spn - SIR-S20, see Figure 3 (Bottom)
• P2-SIR.spn - P2SIR, uncoloured, see Figure 4 (Top)
• P2-SIR.colspn - P2SIR, coloured, see Figure 4 (Bottom)
• network-Europe4.spn - connectivity graph for Europe, 4 countries, un-
coloured, see Figure 5 (Top middle)

• network-Europe4.colspn - connectivity graph for Europe, 4 countries,
coloured, see Figure 5 (Top right)

• P4-SIR.colspn - P4SIR, coloured, see Figure 5 (Middle)
• P4-SIR.spn - P4SIR, uncoloured, see Figure C.2
• P48-SIR-S10.colspn - P48SIR-S10, see Figure 5 (Bottom)
• P48-SIR-S10.andl.spn - P48SIR-S10 unfolded, see Figure 6 (Bottom)
• SIVR.hpn - SIR with variant virus, see FigureC.1
• P10-QI-SIR.colspn - P10Q_ISIR, see Figure C.3 (Top)
• P10-QSIR.colspn - P10QSIR, see Figure C.3 (Bottom)
• P10-SIR_Separate_Rates.cpn - CPN used for parameter optimisation
- unfolded version of P10SIR, given in Figure C.6.

Connectivity networks (provided as CANDL files):

• network-Europe04.candl
- unfolding: |P|=4, |T|=8, |A|=16

• network-Europe05.candl
- unfolding: |P|=5, |T|=16, |A|=32

• network-Europe10.candl
- unfolding: |P|=10, |T|=30, |A|=60

• network-Europe48.candl
- unfolding: |P|=47, |T|=170, |A|=340
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- note: IS isolated, https://countrycode.org
- unfolding time: 1.302sec

• network-China.candl
- unfolding: P|=33, |T|=142, |A|=286
- note: 34 states; TW isolated
- unfolding time: 0.283sec

• network-USA.candl
- unfolding: |P|=48, |T|=210, |A|=420
- note: 50 states; AK, HI isolated
- unfolding time: 1.643sec

PnSIR models (provided as CANDL files):

• P-Europe02-SIR - Europe fragment, 2 countries
• P-Europe04-SIR - Europe fragment, 4 countries
• P-Europe10-SIR - Western Europe, 10 countries
• P-Europe48-SIR - All Europe, 48 countries
• P-China-SIR - China, 34 provinces
• P-USA-SIR - USA, 50 states

Python programs:

• RRHCA (Random Restart Hill Climbing)
• Python Web Scraper, used to to collect COVID19 Data.

R code:

• Europe.Rmd, Western_Europe.Rmd: Both these files take in csv outputs
from Snoopy , Spike to produce correlation matrices and regression analysis.
The Time and Infectious traces are extracted from the csv files and joined
to real world data (e.g. population, density, country size). Correlation
matrices are then produced. Regression analysis is also conducted along
with checking the assumptions of regression.

• Clustering.Rmd: This code takes in one csv file (output from Snoopy , Spike)
and performs agglomerative hierarchical clustering using Euclidean distance
and complete-linkage. This code selects Time and Infected traces to perform
the clustering. The code plots a dendrogram of the clustering results for
visualisation.
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Spike:

• config file + andl/candl file
• all source files to produce Figure C.16.

MC2:

• property library and Unix script to produce Figure C.9.
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